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1. Getting Started 

Wrapsody is a content-based file management solution. Wrapsody allows users to access the latest version of 

a file on their devices (PC or mobile) at anytime from anywhere. Wrapsody helps users easily and quickly share 

information, promoting effective collaboration within an organization. 

1.1. Main Features  
Synchronization and version control 

With Wrapsody, users are able to know whether a Wrapsody file is the latest version when they are trying to 

open to. If not, users can download the latest version themselves uploaded by other users from the server. 

Users can access the latest version by opening and revising the file and uploading the file as a new version. 

Secure access control 

Only the users who have been granted either Revise or View permission can access a Wrapsody file. By doing 

so, Wrapsody prevents reckless or undesired edits on the file. Also, all of the Wrapsody files are saved as 

encrypted. 

Auto backup and version management 

When a user makes modifications on a Wrapsody file and checks in the file, the modified file is registered as 

the latest version on the server. Through the process, all derivative versions of the file are safely backed up. Its 

version history with comments is also automatically saved, providing a timeline of important events on the file. 

Analytics on file usage 

Wrapsody presents a branch map and a usage map of a Wrapsody file. The branch map shows the relations 

among all the branch files derived from a Wrapsody file since its creation, and the usage map shows how much 

the file has been used by a group or user. Wrapsody also offers insight into the file usage status through 

analytics based on the statistics. 

Communications via file 

Users can comment on a Wrapsody file, and the comments will be communicated in real time. It means users 

do not need to exchange emails, calls, and messages with other users. 

Structural tagging 

Administrators or heads of groups can define tags to be used within an organization and designate tags as 

required or optional. Users can choose from either the required or optional tags that have been defined by the 

administrator, or simply input their own custom tags. 

Mobile accessibility 

Users can view Wrapsody files to which they have access not only on their PCs but also on their mobile devices 

with the Wrapsody mobile app at any time in any place. 

1.2. Terminology 
Wrapsody file: A file created through the Wrapsody Client. All derivative versions of the Wrapsody files and 

the version history are stored on the Wrapsody Server.  
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Standard supported applications: Applications supporting the use and management of Wrapsody files include 

MS Office, Hancom Hangul, Notepad, and Acrobat Reader DC. 

Non-standard supported applications: All applications other than those listed as standard supported 

applications provide partial support for Wrapsody file use and management. (Additional configuration is 

necessary for using non-standard supported applications; therefore, please reach out to your Fasoo sales 

representative for further inquiries.) 

Wrap: To convert a file into a Wrapsody file through encryption 

Unwrap: To convert a Wrapsody file back into the state before it was wrapped 

Export original: To export the original file by unwrapping a Wrapsody file 

View: The process of opening and viewing Wrapsody files in Read-only mode. In standard supported 

applications, users with View permissions can open files in Read-only mode. In non-standard supported 

applications, users require Revise permissions to open and edit files. 

View count: The number of times that a Wrapsody file has been opened regardless of its mode (Revise, View, 

or Preview). Views are counted even when a user opens a file after receiving a View request, or while the file's 

check-in remains pending.  

Revise: The process of checking out, modifying, and checking in a Wrapsody file. Users have to open the file as 

a check-out mode to make modifications, and the modified file will be registered as the latest version only 

when you check in the file.  

File owner: A user who is entitled to designate users to view or revise a Wrapsody file. The user who initially 

created the file becomes the owner and the owner is subject to change. A user who is not the owner of a file 

can request to take over the ownership, and the user becomes the owner when the administrator or the 

owner approves the request.  

Administrator: A user in charge of the overall Wrapsody management within an organization. Only the 

administrator is allowed to handle the version delete request, designate the head of the group or other user as 

an administrator. Also, the administrator can change the owner of multiple files at a time, set or define the 

tags, or manage the Wrapsody system (license, notification, or client patch settings.) 

Head of Group: A user in charge of a group within an organization. The head of a group can manage the 

Wrapsody group files and view the related logs. The administrator can designate a user as the head of a group 

at the Organization Setting menu. 

Branch file: A Wrapsody file which has been derived from a Wrapsody file. The branch file has its own version 

history. 

Sharable link: A direct link to download a Wrapsody file. Users who have the link can download the Wrapsody 

file simply by clicking the link and logging in to Wrapsody Web. 

Usage map: A map that shows the file usage by group/user. It is also available to see the usage trend in the 

form of a chart by group/user. 

Branch Map: A map that visualizes all relations between a file and its derivative branch files, which are formed 

since its creation. 
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Timeline: A window that displays the history of file usage and management for each version chronologically. It 

provides management and usage features, such as download, delete, for all versions of a Wrapsody file. 

Wrapsody Server: A server that functions as a centralized repository for all Wrapsody files across various 

versions, offering features such as file usage and efficient management. It supports the use of Wrapsody 

across different platforms and devices.  

Wrapsody Web: An intuitive web interface designed to enhance the utilization and administration of files 

stored on the Wrapsody Server. 

Wrapsody Client: A software program installed on the user’s PC for accessing and utilizing Wrapsody files. 

Wrapsody Mobile: A mobile application designed for accessing and viewing Wrapsody files on mobile devices. 

Wrapsody Drive: A file repository designed for seamless file storage and sharing files. Users can access 

Wrapsody Drive through a web browser or their PC. It synchronizes in real time with the web interface 

(Wrapsody Drive Web) and the user’s PC (Wrapsody Drive for Desktop), ensuring that all files accessed via the 

web or PC are always up to date. 

Wrapsody Drive Web: A web interface offering users a comprehensive view of all files stored in Wrapsody 

Drive. Accessible through a web browser, it provides features for file usage and management, aligning with the 

functionality of Wrapsody Web. 

Wrapsody Drive for Desktop: A version of Wrapsody Drive accessible on users' PCs via the path This PC > 

Wrapsody Drive (W:). Users can manage and utilize folders and files within the familiar structure of File 

Explorer. 

Wrapsody Drive file: A file stored in Wrapsody Drive, either as a Wrapsody file or a plain file with paths within 

Wrapsody Drive. It resides in Company, Group, or Personal Drive, inheriting file usage permissions based on 

the folder in which it is located. 

File ID: Every file on the Wrapsody Server has a unique ID for syncing. Even if files share the same ID but are 

stored in different locations, they stay updated together. This shared sync ID ensures they are always current, 

regardless of where they are stored. 

Offline mode: Wrapsody allows users to open files even when they are offline or disconnected from the 

network. During this offline state, files can be accessed in either Read-only mode or Edit mode based on the 

user's permissions. Once the user reconnects to the Internet or network, any revisions made offline are 

seamlessly updated on the server. 

1.3. Guide Set 
 
Wrapsody Cloud Admin Guide: The guide for the system administrators of an organization that uses 

Wrapsody. This document explains how the administrators can manage company documents and files, 

requests, logs, tags, and the product license.  

Wrapsody Cloud User Guide: The guide for users of an organization that uses Wrapsody. This document 

explains how the users can install the Wrapsody Client on their PC and utilize Wrapsody files on both the 

Wrapsody Client and Web.  
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2. Installation 

2.1. System Requirements 

Classification Category Subcategory Recommended/Minimum Specifications 

Client 

H/W 
CPU: i5 or higher (64 bit) 
RAM: 4GB or higher (8GB recommended) 
HDD: 200GB or higher 

OS 

Windows 

Microsoft Windows 8 (32bit, 64bit): .NET Framework 4.7.1 
manual installation of .NET Framework 4.7.1 required 
Windows 10 1607 (RS1) or higher: .NET Framework 4.7.1 
manual installation of .NET Framework 4.7.1 required 
Windows 10 1709 (RS3) recommended (32/64bit): .NET 
Framework 4.7.1 automatically installed 

Mac 
Sierra (10.12.6), High Sierra (10.13.4), Mojave (10.14.2), 
Catalina (10.15),  Big Sur (11) 

Server 

H/W 
CPU: Xeon 2.5 Ghz Quad Core or higher (64 bit) 
RAM: 16GB or higher (32GB recommended) 
HDD: 100G or higher (Separate storage space required) 

OS 
Windows 2012 or higher (64bit) 

Linux JDK v1.7 or higher 

Mobile OS 
Android 5.0 (Lollipop) or higher 

iOS 11.x or higher 

2.2. Standard Supported Applications  

Applications Extensions 

Microsoft Word 2013 (x86/x64), 2016 (x86/x64), 2019 (x86/x64), Office 365 
Microsoft Excel 2013 (x86/x64), 2016 (x86/x64),2019 (x86/x64), Office 365 
Microsoft PowerPoint 2013 (x86/x64), 2016 (x86/x64),2019 (x86/x64), Office 365 
Microsoft Notepad for Win8 (x86/x64), Win10 (x86/x64), 
Adobe Acrobat Reader DC, Adobe Acrobat Pro DC, 
Hancom Hangul 2010 SE plus, 2014, neo, 2018 

doc, docx, xls, 
xlsx, ppt, pptx, 
txt, hwp, pdf,  
xlsm, docm, hwpx 

Note: For non-standard supported applications, Wrapsody offers partial support for the use and management 

of Wrapsody files. For instance, usability is constrained in these applications due to the absence of features 

like the title bar menu. 

2.3. Install on Windows 

2.3.1. Recover Client 

When an error has occurred while using the Wrapsody Client, you can restore the software using the 

emergency recovery function. 

1. Go to Windows Start > Control Panel > Programs and Features. 

2. Click the Wrapsody Client (or Fasoo Wrapsody) to select Repair at the Organize bar or right-click it to 

select Repair. 
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3. Proceed with the recovery as guided.  

Note: you can also store the Client by selecting Windows Start > All Programs > Fasoo.com > Wrapsody 

Recovery, or reinstall Wrapsody Client using the installation package. 

2.3.2. Uninstall Client 

1. Go to Windows Start > Control Panel > Programs and Features. 

2. Click the Wrapsody Client (or Fasoo Wrapsody) to select Uninstall at the Organize bar or right-click it to 

select Uninstall.  

 
3. Click OK when a confirmation dialog box pops up. 

4. Check if the Wrapsody Client is deleted from the program list.  

3. Basic Operations 

3.1. Log in/out 
If you log in to the Fasoo Enterprise DRM, you can use Wrapsody services.  

3.1.1. Log in 
Follow the procedures below to log in.  

1. Right-click the DRM Client  icon on the system tray and select Login. 

2. Enter your user ID and password and click OK.   

3.1.2. Log out 
Follow the procedures below to log out. 

1. Right-click the DRM Client  icon on the system tray and select Logout. 

2. Click OK. 
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3.2. Create Wrapsody File 

3.2.1. Automatic Wrapping 
When the Automatic Wrapping feature is set by the administrator, plain files will be automatically wrapped 

into Wrapsody files without conducting manual wrapping.  

3.2.2. Manual Wrapping 
When the Automatic Wrapping feature is not set, you can convert plain files to Wrapsody files manually. 

Follow the procedures below to create a Wrapsody file.  

1. Right-click a file.  

2. When you select Create Wrapsody File, a window appears as below.  

 

3. Click  under the Users with Revise Permission or Users with View Permission heading to add users to 

grant View or Revise permissions (See Set Users). 

4. Click  under Tags to add tags to the file. You can directly add a tag by clicking Enter a tag (See Set Tags). 

5. (Optional) You can comment on the file by entering your opinion in the input box. 

6. Finish the Wrapsody file creating process by clicking the Wrap button at the bottom right. 

7. Verify whether the Wrapsody icon overlay is displayed on the file icon (e.g. ). 
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3.2.3. Multiple File Wrapping 
Users can create Wrapsody files at a time. 

1. Select multiple plain files or select a folder containing multiple plain files. Right-click the files or the folder. 

2. When you select Create Multiple Wrapsody Document, a window appears as below. 

 

3. Click  under the Users with Revise Permission or Users with View Permission heading to add users to 

grant View or Revise permissions (See Set Users). 

4. Click  under Tags to add tags to the file. You can directly add a tag by clicking Enter a tag (See Set Tags). 

5. Under Options, select desired options by clicking checkboxes to the left. 

 Include all files in subfolders: The files contained in the subfolders of the selected folder will become 

target files for wrapping. The newly wrapped files will inherit the user and the tag properties set 

before. To change the properties of multiple Wrapsody files at once, see Manage Multiple Files. 

 Add the name of the folders containing the target files as new tags: The name of the folder to which 

the target files belong will automatically be added as a new tag to the Wrapsody files.  

6. Click the Next button. 
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Note: Only the file extensions specified in the Target extensions can be wrapped simultaneously. When 

the target extension is ALL, any files can be wrapped at a time regardless of extensions. 

7. Check the File path, Status, and Details related to the wrapping process. 

8. Check the options selected at the previous stage at the bottom. You can reselect them at this stage. 

9. Start the wrapping process by clicking the Start button. 

10. When the wrapping is complete, the status of the file is changed from Ready to Complete, and the Start 

button to the Close button. 

11. Click Close to close the window. 

12. Verify whether the Wrapsody icon overlay is displayed on the file icon (e.g. ). 
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3.2.4. Set Users 

If you click  under the Permission heading in the Create Wrapsody File window, you will see the Set Users 

window. To set permissions for users or groups, check out the details in the Set Users section. 

3.2.5. Set Tags 

If you click  under the Tag heading in the Create Wrapsody File window, you will see the Set Tags window. 

Follow the procedures below to add tags to the file. 

 

❶ Search for a registered tag. 

❷ Select registered tags, which may differ depending on company settings. 

❸ In Wrapsody Cloud, “Wrapsody” is set as the default tag.  

❹ To add tags, click Enter a tag, type in a tag, and press the Enter key. The entered tags will be added.  

❺ Click Apply to complete the tag settings.  

  

❶ 

❷ 

❸ 

❹ 

❺ 
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3.3. View Wrapsody Files 
To view a Wrapsody file, you need either View or higher-level permissions. If you do not have any, request 

permission first (see Request). If the file owner or the administrator approves the request, you will be granted 

the permission you asked for. 

Note: For applications that are not standardly supported, accessing Wrapsody files requires at least Revise 

permissions. If you intend to use non-standard supported applications, please contact your Wrapsody 

administrator, as additional configuration may be required. 

1. Double-click a Wrapsody file. Or right-click the file and select Open Wrapsody Document from the context 

menu to open its latest version. If you want to open the version of a local file saved on the PC, not the 

latest version of the file, right-click the file name and select the Open Wrapsody Local File.  

Note: When a dialog box asking in which mode you want to open the file appears according to the company 

policy set by the administrator, click Open. If you want to open the version of a local file saved on the PC, not 

the latest version of the file, click View local document right above the file name. 

 
When a user has only View permission, the dialog box might not appear and the file will be automatically 

opened in View mode. 

2. If users have either View or Revise permission, the file will be opened in View mode by default. When a 

user has only View permission (or according to the company policy set by the administrator), the file will 

be automatically opened in Read-only mode and cannot be changed to Revise mode with the following 

message:  

 
3. You will see the badge menu as below on the top right corner of the application window and can check 

that you are in View mode, or Read-only mode. 

 
❶ The current state: View mode (read-only) 

❷ View/Revise toggle: You can switch the mode between View and Revise. Slide the toggle button right 

  to switch to Revise mode.  

❸ Ver.: Current version/total version number is displayed.   
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❹ Manage Document: You can open the Manage Wrapsody File window. 

❺ Update Document: You can download and open the latest version from the server. The option is 

 enabled when the file is updated on the server. On the other hand, it will be disabled when the latest 

 version has been checked out or when offline. 

❻ Request: You can request Revise Permission, Transfer File Ownership, End Editing for the file. (See 

 Request) 

❼ Send View Alert: You can send a request to other users (users with Revise permission) to view the file. 

❽ Comment: You can leave a comment on the file. All comments on a file can be seen on the Timeline 

 window with See version details activated. (See Timeline features > See version details) 

❾ Document Chat: You can chat with users who have View/Revise permission on the Wrapsody file.  
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3.4. Revise Wrapsody Files 
To revise a Wrapsody file and create a new version, you have to open a Wrapsody file in Revise mode, not in 

View mode. Only those with Revise permissions can open Wrapsody files in Revise mode. 

Note: Wrapsody supports file revisions in non-standard supported applications as well. If you intend to use 

non-standard supported applications, please contact the Wrapsody administrator, as additional configuration 

may be required. 

3.4.1. Check out 
Revising a Wrapsody file requires owning Revise permission for the file. If you do not have Revise permission, 

you can receive it by making a request (see Request) to the file owner or the administrator. Once the request 

is approved, check out by following the procedures below:  

1. Double-click a Wrapsody file to check out. Or right-click the file and select Open Wrapsody Document 

from the context menu to open its latest version. If you want to open the version of a local file saved on 

the PC, not the latest version of the file, right-click the file name and select the Open Wrapsody Local File. 

Note: When a dialog box asking whether to open the file in View or Revise mode appears according to the 

company policy set by the administrator, click Check out. 

 

If users have Revise permission but the file is in Revise mode by other users, Check out is disabled and you can 

only view the file. If the file is being checked out by other users, you can send an End Editing request to the 

user who is revising the file or to the file owner so that the user can check in or the owner can force the end of 

editing. 

 

2. Even for users with Revise permissions, the file is opened in View mode by default with the message pop 

up as below: 

 
3. The mode will be automatically changed to Revise mode once you start editing the file. You will see the 

badge menu as below on the top right corner of the application window and can check that you are in 

Revise mode, or the Edit mode.   
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❶ The current state: Revise mode (editable) 

❷ View/Revise toggle: You can switch the mode between View and Revise. Slide the toggle button left to 

switch to View mode. 

❸ Ver.: Current version/total version number is displayed.  

❹ Manage Document: You can open the Manage Wrapsody File window.  

❺ Request: You can request Transfer File Ownership, End Editing for the file (See Request). 

❻ Send View Alert: You can send a request to other users (users with View/Revise permission) to view 

the file. 

❼ Comment: You can leave a comment on the file. All comments on a file can be seen on the Timeline 

window with See version details activated (See Timeline features > See version details). 

❽ Document Chat: You can chat with users who have View/Revise permission on the Wrapsody file.     

❾ Save Current File to Server: You can update the file by saving the changes to the server without check-

in process and continue to work on the new version of the file. 

4. Start editing. 

5. To upload the modified file as the latest version to the server, you have to check in the file (See Check in). 

  

❶ 

❷ 

❸ 

❺ 

❼ 

❹ 

❾ 

❽ 

❻
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3.4.2. Check out (Process multiple Wrapsody files in a single application) 
When multiple files are opened in a non-standard supported application, and the prompt to select 

View/Revise mode for each file does not appear, follow these steps to initiate the checkout process. 

1. Open multiple Wrapsody files in one application. 

2. An alert message will appear at the bottom right indicating the number of files available for updating and 

revision. 

 

3. Click on the message prompt. Alternatively, right-click the Wrapsody icon  in the system tray and select 

View File Updates. 

4. Click on the Revision tab. 

5. Click the Check Out button for the file you wish to revise. To check out for multiple files at once, click the 

checkboxes next to the files, then click the Check Out button at the top. 

Note: Once the file is checked out, the prompt in the Available actions item will change to Cancel Check-out. 

For the check-in, a check-in selection dialog will appear for each file, similar to the process in standard 

supported applications, when you modify, save the file and close it. 

3.4.3. Check in 
Check-in is required to register the Wrapsody file on the server as the latest version after editing. 

1. Save the edits and close the file.  

2. A dialog box appears asking whether to check-in (Check In), hold check-in (Not Now), cancel check-in 

(Cancel). According to the company policy set by the administrator, the following dialog box might not 

appear. In that case, the file will be checked in automatically without the following steps. 

 
3.  (Optional) Click the  icon to the right of the file name to rename the file.   

4. If you want other users to view the newly revised version, send a View request by selecting Viewers or 

Revisers under the Send request to view to heading. To specify the target users, click the combo box to 

the left of Select target and select users from the list. 
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5. (Optional) Enter a comment in the comment text area if necessary. 

6. If you select the Check in automatically when closing it on the current PC option, check-in is completed 

automatically with no dialog box popping up when you close the window after editing. If you want to 

change the option later, please see Wrapsody File Manager > Settings. 

7. Click the Check In button to save the modified as the latest version on the server. 

3.4.4. Cancel check-out 
You can cancel check-out to maintain the previous version as the latest version and discard the changes of the 

checked-out file. 

1. Save the edits and close the file. 

2. A dialog box appears asking whether to check-in (Check In), hold check-in (Not Now), cancel check-in 

(Cancel). According to the company policy set by the administrator, the following dialog box might not 

appear. In that case, the file will be checked in automatically without the following steps. 

3. Click the Cancel button. 

4. The check-out is canceled when you click OK on the following dialog box. 

3.4.5. Cancel check-out (Process multiple Wrapsody files in a single application) 
When multiple files are opened in a non-standard supported application, you can cancel the revision of a file 

that has been checked out using the following method. 

1. Open multiple Wrapsody files in one application. 

2. An alert message will appear at the bottom right indicating the number of files available for updating and 

revision. 

 

3. Click on the message prompt. Alternatively, right-click the Wrapsody icon  in the system tray and select 

View File Updates. 

4. Click on the Revision tab. 

5. Click the Check Out button for the file you wish to cancel the check-out for. 

3.4.6. Hold check-in 
You can hold check-in if you want to update the version to the server at a later time. Follow the procedures 

below to hold check-in. This feature is not provided for manual check-in. 

1. Save the edits and close the file. 

2. A dialog box appears asking whether to check-in (Check In), hold check-in (Not Now), cancel check-in 

(Cancel). 

3. Click the Not Now button. 

4. Close the file. The modifications will be saved only on your PC and not be updated to the server.  

Note: If other users check in the file for which you have held check-in, your version on hold will be opened 

only in View mode and any modifications made will be saved on your PC only. 

Follow the procedures below to check in the file on hold. 

Option 1. Manage Wrapsody File window 

1. Right-click a file on hold and select Manage Wrapsody File. 

2. Click Check In on the top right of the window. 

3. Enter a comment if necessary on the dialog box and click OK.  
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Option 2. Wrapsody File Manager 

1. Go to Wrapsody File Manager > My PC . Select a file to check in (See Wrapsody File Manager > My PC). 

2. Click the  icon to the rightmost side of a file to check in and select Check In. 

3. Enter a comment if necessary on the dialog box and click OK. 

3.4.7. Manual check-out 
Users with Revise permission for file types that support manual check-out can edit the file and update it as the 

latest version to the server either on a web browser or a client side through manual check-out features. 

However, the supported extensions (e.g., .dwg, .dxf, .nwd, .nwf, .nwc) may vary depending on the company, so 

please contact your administrator for more details. 

Note: You may check out a file without clicking Check Out on the Manage Wrapsody File window. Just open a 

file, edit and then check out manually. However, using the manual check-out feature prevents other users 

from checking out the same file at the same time.     

Option 1. Wrapsody Client 

1. Right-click a file to check out manually and select Manage Wrapsody File. 

2. Click the Check Out button at the top of the Manage Wrapsody File window. The button is not enabled 

when the file does not support manual check-out or the user does not have permission.   

 
3. Open and edit the file.   

Option 2. Wrapsody Web 

1. On the Document tab, place the mouse pointer over a file to check out manually. 

2. Click the More  icon under the Owner heading. 

3. Click Manual Check-in from the context menu. The button is not enabled when the file does not support 

manual check-out or the user does not have permission. 

4. The file is downloaded to the user’s PC. 

5. Open and edit the file.  
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3.4.8. Manual check-in 
Manual check-in is required to register the manually checked-out Wrapsody file to the server as the latest 

version after editing.  

Note: You may check out a file without clicking Check Out on the Manage Wrapsody File window. Just open a 

file, edit and then check out manually. However, using the manual check-out feature prevents other users 

from checking out the same file at the same time.     

Option 1. Wrapsody Client 

1. Save the edits and close the file. 

2. Right-click a file and select Manage Wrapsody File. 

3. Click the Check In button at the top of the Manage Wrapsody File window to save the edits to the server 

as the latest version. 

 

Option 2. Wrapsody Web 

1. Save the edits and close the file. 

2. On the Document tab, place the mouse pointer over a file to check in manually. 

3. Click the More  icon under the Owner heading. 

4. Select Manual check-in. 

5. Drag the edited file to the box below, or click choose a file to upload the file. 

 
6. Enter a comment if required and click Check In.   

7. The changes are saved to the server as the latest version. 
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3.4.9. Manual check-in for multiple files 
Multiple files that had been manually checked out can be checked in at the same time. 

Note: You may check out files without clicking Check Out on the Manage Wrapsody File window. Just open 

files, edit each of them and then check them in manually at once. However, using the manual check-out 

feature prevents other users from checking out the same file at the same time. 

1. Select and right-click several files edited and checked-out manually. 

2. Select Check-in Multiple Wrapsody Document.   

3. Check the list of target files on the Check-in Multiple Wrapsody Document window and uncheck for files 

not to check in. 

 
4. Click Start at the bottom.    

5. Check the status of the files and click Completed at the bottom.  

 
6. Files with its status ‘Completed’ are saved to the server as the latest version. 

3.4.10. Cancel manual check-out 
You may cancel check-out to maintain the previous version as the latest version on the server and discard the 

changes of the checked-out file. 
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1. Save the edits and close the file. 

2. Right-click the edited file and select Manage Wrapsody File.  

3. Click the Cancel Check-out button at the top of the Manage Wrapsody File window. 

4. When the Cancel Check-out dialog box shows up, click Yes. 

5. The check-out is canceled and the previous version is saved as the latest version on the server. However, 

the modified file is not deleted but saved on the user's PC and managed a separate Wrapsody file.    
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3.5. Update files 
This process involves fetching and storing the latest version from the Wrapsody server when the version of a 

document stored locally is not the most up-to-date. 

Note: Even applications not standardly supported can support updating Wrapsody files. If you intend to use 

non-standard supported applications, please contact the Wrapsody administrator, as additional configuration 

may be required. 

3.5.1. Update files 

Case 1. Standard supported applications 

1. Open a Wrapsody file in View mode. 

2. Click the More button at the top right in View mode. 

 
3. If the currently open file is not the latest version, Update Document is activated. 

4. Click on Update Document. 

5. The latest version of the document will open. 

Case 2. Non-standard supported applications 

If you open an older version of a file or if another user checks out a file after you've opened it, you can update 

to the latest version by reserving the update upon application closure or when closing the file. If multiple 

applications are open, the update alert at the bottom right displays the number of files requiring update 

among all files open in all applications. 

If you make edits to the currently open version and save it while a newer version exists, the file will update 

upon closing, and simultaneously, the changes made in the currently open version will be saved as its branch 

file. 

1. Launch Wrapsody files in an application. 

2. If the latest versions of the files exists, an alert message will appear at the bottom right. 

 

3. Click on the message prompt. Alternatively, right-click the Wrapsody icon  in the system tray and select 

View File Updates. 

4. Click the Book button for the file you want to update. To update multiple files at once, click the 

checkboxes next to the files, then click the Book button at the top. 

 
5. The update for the files is reserved and will be updated upon application closure. 
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Note: Once the update is booked, the prompt in the Update item will change to Cancel. Click the Cancel to 

cancel the update reservation. 

3.5.2. Check file update history 
When you schedule a file update in non-standard supported applications, the update will proceed upon closing 

the application or closing the file. You can verify the completion of the update and check the Details  and 

Folder path  of the updated files. 

1. Click on the Wrapsody icon  in the system tray 

2. Go to the Update History tab. 

Note: The update history will be reset when your PC or the Wrapsody application is restarted. 

3.6. Manage Wrapsody Files 
Note: You must have either View or the Revise permission for a file to access the Manage Wrapsody File 

window. If you have no permission, a Request window will pop up instead of a Manage Wrapsody File 

window. Request permission first through the Request window, and open the Manage Wrapsody File window 

once permission is granted (See Request). 

3.6.1. Manage Wrapsody File window 

To open the Manage Wrapsody File window with Details and Timeline tabs, right-click a Wrapsody file and 

select Manage Wrapsody File. Manage the file on the desired tab based on the information and features 

needed. Note that displayed information and features depend on user permissions. For handling multiple 

Wrapsody files, see Manage Multiple Files. 
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Details 

 

❶ Basic info: Displays essentials details such as the file’s name, version, size, and its location on the user’s PC. 

Clicking the path opens the folder containing the file in a new window. 

Note: For a Wrapsody Drive file, if you have permission for the correspondent folder in Wrapsody Drive, the 

path in Wrapsody Drive for Desktop will be displayed as well. Clicking the path opens the folder in a new 

window. 

❷ Icon menu: Displays features for both using and managing the Wrapsody file. 

Icon Menu Description 

 Starred 
Store files you frequently use or plan to access soon. You can access 
the files easily and quickly on the Starred tab on Wrapsody Web 
whenever you need them later. 

 Update 
Download the latest version from the server if the file is not the 
latest version. You can update only your owned files. 

 Download Download the Wrapsody file to your PC. 

 Preview View the file in a Preview window without downloading it to the PC. 

 Create Link Create a link to share the file with other users. 

 Export Original 
Unwrap a Wrapsody file to export its original file separately. The 
Details window on Wrapsody Web, however, does not support this 
feature. 

 Create Branch 
Create a Wrapsody file which has been derived from the original 
Wrapsody file. The branch file has its own permissions and version 

❶ 

❷ 

❸ 

❹ 

❼ 

❺ 

❻ 
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history. The Details window on Wrapsody Web, however, does not 
support this feature. 

 Document Chat 
Chat with users who have View/Revise permissions for the 
Wrapsody file. The feature is exclusively supported in cases where 
Fireside is installed. 

 Send View Alert 
Send an alert encouraging or urging other users (those with 
Revise/View permission or selected users) to view the file. 

❸ General: Displays the file info of Owner, Date revised, and Modifier. 

 If the selected file is not owned by you, the  button is enabled. Click the button 

to initiate a request for file ownership transfer from the current owner to yourself. 

 If the file is checked out, Checked out by is displayed instead of Modifier. 

 

❹ Permission: Displays a list of users with each Revise/View permission.

 

  is exclusively enabled for users with View permissions but not Revise 

permissions. Click the button to request Revise permission. 

  is exclusively enabled for the file owner. Click the button to grant Revise or View 

permissions to users. For information on setting permissions for users or groups, refer to the details in 

the Set Users section. 

 ❺ Tag: Displays the tag info of the file.  The required tags are in deep green with a green border. 

Optional tags are in black with a grey fill. Tags freely added by the owner are in black with a white fill. 

If you have Revise permission, you can both add and remove optional tags or any tag you desire (See 

Set Tags). 

 To add tags, click  under Tag. You can add optional tags or create a new one by typing it 

into the Enter a tag text area. 

 To remove tags, simply click the X button next to the tag. You can delete either optional tags or tags 

added by the owner. 

❻ Receive revision notifications: Select the checkbox to receive a notification when the newest 

version of a file is checked in.  

❼ Receive comment notifications: Select the checkbox to receive a comment notification when 

another user comments on the file. 

Set Users 

In a Details window,  is exclusively enabled for the file owner. Click it to grant Revise or View 

permissions to users. 
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❶ Basic info: Displays the file’s name and size. For Wrapsody Drive files, the path in Wrapsody Drive for 

Desktop will also be displayed. 

❷ Select users: Under the Select from group tab, select a group or user, or type the user name/ID or group 

name in the search text area. Alternatively, you can select a favorite user or group under the Favorites tab. 

Pick users to grant permissions, then click  to add them to the list on the right. 

 Select from group: Select the desired group or user from the organization chart.  

 Favorites: Select a favorite user group that you have previously defined.  

❸ User list: Displays a list of users with existing and newly added permissions. Click the toggle button next to 

a user or group to grant Revise or View permissions. For Wrapsody Drive files, it provides details on folder 

permissions, including the folder manager and users/groups with Read or Write permissions. 

❹ Options: Select if needed. 

 Allow all users to view: Grant View permissions to all users. If you add a user with this option selected, 

Revise permission is automatically granted to the user. 

 Send email notifications for permission granting: Send email and notifications to newly added users 

when permissions are granted. 

❺ Apply/Cancel: Click Apply to confirm the user settings. If you click Cancel, any newly configured 

permissions will not be applied, and the Set Users window will close. 

❶ 

❷ ❸ 

❹ ❺ 
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Timeline 

 

❶ Basic management info: Displays the latest version’s file name, view rate, number of GCC target versions, 

file size, date of the version created. 

 View rate: The number of users who viewed the file out of users with View permissions for the file. 

 GCC target version: Files that are categorized as GCC (Garbage Content) recommended to be managed. 

 File size: The file size of the latest version. 

 Date of the version created: The date when the latest version is created as the file is checked-in. 

❷ Icon menu: Use and manage each version of the file, and explore the Usage Map and Branch Map for each 

version. See the table below to learn more information on icons. To learn more about features, see Timeline 

Features. 

Icon Menu Description 

 Download Download the Wrapsody file to your PC. 

 Preview View the file in a Preview window without downloading it to the PC. 

 Usage map 
A map that shows the file usage by group/user. It is also available to see 
the usage trend in the form of a chart by group/user. 

 Branch Map 
A map that visualizes all relations between a file and its derivative branch 
files, which are formed since its creation. 

 Create Link Create a link to share the file with other users. 

 Document Chat 
Chat with users who have View/Revise permissions for the Wrapsody file. 
The feature is exclusively supported in cases where Fireside is installed. 

❸ Usage history by version: Provides basic info including file name, file size and modifier, and displays usage 

history through icons. Download, Preview, Comment, Delete Versions and Copy to the Latest Version are 

❶ 

❷ 

❸ 
❹ 

❺ 

❻ 
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available. See the table below to learn more information on icons. To learn more about features, see Timeline 

Features. 

Icon Menu Description 

 Download Download the Wrapsody file to your PC. 

 Preview View the file in a Preview window without downloading it to the PC. 

 Comment Leave a comment on the latest version. 

 
Copy to the 

Latest Version 
The file owner can register one of the previous versions as the latest 
version. 

 Delete Versions 
The file owner or the user who created a specific version is able to delete 
the previous version of the file. 

❹ Version Management: View and manage previous versions as well as the latest version of a file and 

designate a previous version as the new latest version. 

❺ Apply and Reset Filters: Clicking Show Filter will reveal filter icons below, each representing the past use 

and management of the file, along with the number of times each action happened. 

 
Icon Item Description 

 Comment Users with View or Revise permissions leave a comment 

 Permission View or Revise permissions are granted or withdrawn 

 Request 
Requests for View or Revise permissions, Export original, file ownership 
transfers and End editing are approved or rejected. Request for 
exporting the original is exclusive to an SE environment. 

 Send View Alert 
Users with View or Revise permissions request other users to view the 
file 

 Tag Tags are added or deleted 

 Name Change The file is renamed 

 Export Original The original of the file is exported 

 Create Link A sharable link to share a file is created 

 Latest Version One of previous versions is designated as the new latest version 

 Delete A version is deleted 

 View Users with View or Revise permissions view the file 

 Create Branch A branch file is created 

❻ See version details: Slide the See version details switch to the right to see the usage and management 

history of the file, along with basic info including when and who performed each action. 

3.6.2. Export Original 

Unwrap a Wrapsody file and export it as a plain file. Here are the ways to export the original. 

Note: You cannot export the original of a Wrapsody file which has been checked out. To unwrap a Wrapsody 

file, check in the file or cancel the check out. If the file has been checked out by other users, request End 

Editing first (See Request for Permission or Actions > ❹End Editing). 

Option 1. Manage Wrapsody File window  

1. Right-click a Wrapsody File, and select Manage Wrapsody File > Export Original  icon. 

2. From the Save As dialog box, choose a location and specify a file name, and click the Save button. 

3. The unwrapped original file is generated with the specified name at the designated location. 

4. Check if the wrapping overlay icon at the right bottom of the icon is removed. 
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Option 2. Wrapsody File Manager 

1. Double-click the Wrapsody  icon from the system tray to open Wrapsody File Manager. 

2. Go to the My PC  tab (See Wrapsody File Manager > My PC). 

3. Right-click the More  icon located to the far right of a desired file in the list and select Export original. 

4. From the Save As dialog box, choose a location and specify a file name, and click the Save button. 

5. The unwrapped original file is generated with the specified name at the designated location.   

6. Check if the wrapping overlay icon at the right bottom of the icon is removed. 

3.6.3. Timeline features 

In Timeline, you can check the history of each version of the file. You can also download or delete any 

versions, preview them and set them as the latest version. By exploring the branch map and usage map, you 

can gain a comprehensive overview of the current file usage.

 

Download a file 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. Click the Download  icon at the top. 

3. From the Save As dialog box, choose a location and specify a file name, and click the Save button. 

4. The latest version of the file is generated with the specified name at the designated location. 

Preview a file 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. Click the Preview  icon at the top. 

3. The preview of the latest version will open in a web browser. 

Create a sharable link 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. Click the Create Link  icon at the top. 
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3. A link that can be shared with other users to provide access to the file is copied to the clipboard. 

Document Chat 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. Click the Document Chat  icon at the top. 

3. The Document Chat Room, or the Wrapsody Room, will open. 

Branch Map 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. Click the Branch Map  icon at the top. 

3. The window below offers a holistic view of the current usage of branch files of the Wrapsody file. 

 
Click the circle to the left of each branch file name to display usage information at the top right of the map. For 

the description of each item, see the table below. 

Item Description 

File name The name of the latest version of the clicked file  

Viewed 

The number of times the clicked file has been viewed 
Note: The View count include instances when a Wrapsody file has been 
opened regardless of its mode (Revise, View, or Preview). It is all counted 
in the view count if a user opens a file upon a View request or on hold 
(before checking in the file). 

Revised The number of times the clicked file has been checked in 

File owner 
The Name (ID)/Group/Title of the user who originally created the clicked 
file on the map. 

Date created The time and date when the clicked file on the map was initially created. 

Selected version 
To view the usage map for all versions, click the downward arrow to select 
all. Click individual versions to see the usage map specific to that version 
of the file. 

Usage map 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. Click the Usage Map  icon at the top. 
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3. The window below offers a holistic view of the current usage of branch files of the Wrapsody file. 

 
Select organization, group, or user boxes to display usage information at the top right of the map. For the 

description of each item, see the table below. 

Item Description 

Group (or User) 
Selecting an organization or group box reveals only the Group name 
whereas selecting a user box reveals both the User and Group names. 

User The number of users with View or Revise permissions 

Viewer The number of users who viewed the file 

Total usage The total view counts that each organization, group, or user viewed the file 

Title When a User box is selected, the user’s title is displayed. 

Viewed 
When a User box is selected, the number of times that the user has viewed 
the file is shown. 

Selected version 
To view the usage map for all versions, click the downward arrow to select 
all. Click individual versions to see the usage map specific to that version of 
the file. 

Export Usage 
Export the data of the usage map you are viewing as a file. To save the data 
as an Excel (.csv) file on your PC, click Export Usage. 

Usage Chart 
The graph displays the daily view counts for the chosen organization, group, 
or user. 

Comparison Chart 

Click Comparison Chart in an info box to add the organization, group, or user 
to the Target to compare. Adding two or more targets displays the Create 
Comparison Chart button at the bottom. If you click the button, a usage 
comparison chart will be created and appear on a new window. 

Target to compare 
Displays the number of target organizations, groups, or users that can be 
compared in the form of ‘number of added targets/maximum number of 
targets to compare’. 

Do not show 
unread documents 

If the box is checked, groups or users that have not viewed the file will not 
be displayed on the map. 

Download a version 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. Hover over the version to download. 

3. Click the Download  icon on the right. 
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4. From the Save As dialog box, choose a location and specify a file name, and click the Save button. 

5. The version of the file is generated with the specified name at the designated location. 

Preview a version 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. Hover over the version to preview. 

3. Click the Preview  icon on the right. 

4. The preview of the version will open in a web browser. 

Delete versions 

The file owner or the user who created a specific version is able to delete the version of the file. 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab. 

2. If the checkbox to the left of a version is checked, the Delete Version  icon will appear at the top. Or 

hovering over a version to delete reveals the same icon on the right. 

3. If you click the Delete Version  icon, the Delete versions dialog box will pop up. 

4. Click Delete to delete the version. 

Copy to the latest version 

Only the file owner can access this feature. 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Timeline tab.  

2. Hover over a version to set as the latest version, excluding the current latest version. 

3. If you click the Copy to the Latest Version  icon, the Copy to Latest dialog box will pop up. 

4. Click OK to set the version as the new latest version. 
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See version details 

1. Slide the See version details switch to the right under Show filter. 

 
2. The types of file usage and management actions for each version, including View, Create version, Change 

permission, Comment and Create Link, will be displayed, along with when and who performed each 

action. 

3.6.4. Create a branch file 

1. Right-click a Wrapsody File, and select Manage Wrapsody File > the Details tab. 

2. Click the Create Branch  icon at the top. 

3. From the Save As dialog box, choose a location and specify a file name, and click the Save button.   

4. When the dialog box pops up, click Yes to apply the same settings for users and tags as the original file or 

click No to create without any user or tag settings.  

 
5. After the pop-up message indicating the successful creation of a branch file appears, click the OK button. 

6. The branch file will be created at a specified location.  
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3.6.5. Request 

If you have no permission for the file, you can obtain them by submitting a request. 

1. Right-click a Wrapsody File, and select Manage Wrapsody File. The Request window will appear as 

below. 

 
2. Select the request type according to your specific needs. 

❶ View permission: When you need View permission (can read) for the file. 

❷ Revise permission: When you need Revise permission (can edit) for the file  

Note: You also have the option to request View/Revise permission through the web browser (See 

Additional menu > Request). 

❸ Transfer File Ownership: When the ownership of a file has to be transferred to you.  

❹ End Editing: When another user has checked out the file. 

3. Enter a reason for the request and click OK. 

  

❶ ❷ ❸ ❹ 
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3.6.6. Manage multiple files 

Follow the procedures below to change the properties of multiple Wrapsody files at a time.  

1. Right-click a folder containing multiple Wrapsody files, or select and right-click multiple Wrapsody files.  

Note: Make sure that you do not select an empty folder or plain files when selecting multiple targets. If 

the target includes plain files, only the properties of Wrapsody files are subject to modification.  

2. Select Manage Wrapsody File.  

Note: Only the owner of the target files is entitled to set the properties as below. 

 
❶ To grant either View or Revise permission to a user, click Modify to the right of Users with added 

Revise permission or Users with added View permission or click . 

❷ To withdraw View or Revise permissions from users, click Modify to the right of Users with removed 

Revise permission or Users with removed View permission or click . 

❸ Click  to the right of Add tags to add tags. To delete a tag added before, click the X in the tag box or 

click Modify to the right of Remove tags. 

❹ Choose options. 

 Include all files in subfolders: The properties of all the files contained in the subfolders of the 

selected folder are also subject to modification.  

 Override the properties of the existing Wrapsody documents: The properties of the selected 

files will be overwritten with the new settings.  

 Add the name of the folders containing the target files as new tags: The name of the folder 

containing the target files is added as a new user tag.  

❺ Click Next at the bottom when the settings are completed. 

3. Check the properties set at the previous stage in the window as below. Modify options as required.  

❶ 

❷ 

❸ 

❹ 

❺ 
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❶ Check the File path, Status and Details of target files.   

❷ You can modify options specified at the previous stage. 

❸ Click Start at the bottom to apply the settings. When the settings are completed, the Status will switch 

from Ready to Complete. Click Close to close the window. To check the changed settings, right-click each 

file to choose Manage Wrapsody File. 

 

  

❶ 

❷ 

❸ 
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3.6.7. AI Document Helper 
Note: Please contact your Wrapsody administrator to utilize this feature. 

AI Document Helper analyzes Wrapsody files and Wrapsody Drive files based on AI technology. In the 

document preview window, you can freely ask questions about files to AI Document Helper and easily get 

answers. 

1. Right-click on a Wrapsody file and select Open Wrapsody File Preview. 

2. The document preview will open in a web browser. 

3. Click on the AI Document Helper  tab on the right. 

4. The AI Document Helper window will expand. 

5. Click on the guided questions in the window or directly input your question and press Enter. 

6. AI Document Helper will generate and provide the answer. 

3.7. Features Exclusive for Wrapsody Cloud Enterprise or Higher-level Plans 

3.7.1. Request for one-time export of original 

In a Wrapsody Cloud Enterprise plan or higher-level plans, exporting the original is restricted. Submit a request 

for a one-time export of the original to either the file owner or the Wrapsody administrator. If the request is 

approved, the file will be unwrapped and saved as a separate file only once. If you have no permission for the 

file, you can request View or Revise permission (see Request) first and then request a one-time export of the 

original. 

Option 1. Manage Wrapsody File window 

1. Right-click the edited and select Manage Wrapsody File. 

2. Click the Export Original  icon at the top. 

 
3. When the Request for Export Original dialog box appears, enter a reason for the request and then click 

OK. 

Option 2. Badge menu 

1. Open a Wrapsody file in an application. 

2. Either from the View or Revise badge menu at the top, click the  button. 

3. Select Request from the menu. Then the Request dialog box will appear as below. 
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4. Select Export Original and enter a reason for the request. Then click the OK button at the bottom. 

5. When the dialog box indicating that the request has been submitted appears, click the OK button. 

Option 3. Wrapsody File Manager 

1. Double-click the Wrapsody  icon from the system tray to open Wrapsody File Manager. 

2. Go to the My PC  tab (See Wrapsody File Manager > My PC). 

3. Right-click the More  icon located to the far right of a desired file in the list and select Export original. 

4. When the Request for Export Original dialog box appears, enter a reason for the request and then click 

OK. 

3.7.2. Process the Save As action 

In a Wrapsody Cloud Enterprise plan or higher-level plans, a branch file is created through the Save As action 

only when a user possesses Revise permission for the file or owns the file. Users who have only View 

permission cannot create a branch file using this action. 

3.7.3. Review detailed permissions 

In a Wrapsody Cloud Enterprise plan or higher-level plans, detailed capabilities for Owners, users with Revise 

permission, and those with View permission are presented in the Details window of a Wrapsody file. This 

window is accessible both on the user’s PC and the web interface. To view specific details for each permission, 

hover over the  icon next to the respective permission. Please note that this feature will not be supported 

for plain files. 

To open the Details window on the user’s PC, right-click a Wrapsody file on your PC and select Manage 

Wrapsody File. To access it on Wrapsody Web, hover over a file in the file list and click the Details  icon. 
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For a description of each detailed permission, refer to the table below. 

Item Description 

View The ability to open and read the Wrapsody file. 

Edit The ability to open and edit the Wrapsody file. 

Print The ability to print the Wrapsody file. 

Screen capture The ability to capture screenshots while the Wrapsody file is open. 

Copy to plain file 
The ability to copy and paste the contents of the Wrapsody file into a plain 
file. 

Export Original The ability to unwrap the Wrapsody file and export its original file. 

Manage request 
(Export Original) 

The ability for the file owner to process requests from other users for a one-
time export of the original file. 
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4. Wrapsody Client 

4.1. System Tray Configuration 

Right-clicking the Wrapsody  icon on the system tray will show the context menu as below.  

 
❶ The received notifications are displayed in real time. 

❷ Open Wrapsody Server Website. 

❸ Open Wrapsody File Manager.  

❹ Check for files that can be updated or revised in non-standard supported applications. 

❺ If the Wrapsody Client installed on your PC is not the latest version, update it to the latest. 

❻ Open the Settings window. 

4.2. Notifications 

Clicking the Wrapsody  icon on the system tray will open the Wrapsody notifications window as below.

 
❶ All: All messages, including Important notifications, are displayed.   

The Preview , Manage Wrapsody File  and More  buttons will show up when hovering over a 

notification item on the list. The Download and Go to Wrapsody Server items will appear when clicking the 

More button. 

❷ Important: Notifications on request for a user’s action (Revise Permission, View Permission, End Editing, 

Transfer File Ownership, etc.) are categorized and shown on the list. Click the Approve or Reject button to 

approve or reject the selected request. 

❸ Update History: Displays the history of updates conducted in non-standard supported applications. You 

can verify whether the updates were completed successfully or failed. 

❹ One of the following messages are displayed to show whether the notification list is up-to-date or not.   

 The list is up to date. 

❶ 

❷ 

❸ 

❹ 

❺ 

❻ 

❶ ❷ ❸ 

❹ ❺ 



 

Wrapsody Cloud v5.9.2 User Guide | Page 46 

 Synchronizing… 

 You are currently offline. 

 Failed to synchronize the list.  

❺ More: The following menu appears when clicking the More  button.  
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4.3. Wrapsody File Manager 
You can find and manage all the Wrapsody files on your PC with the Wrapsody File Manager. To open the File 

Manager, double-click the Wrapsody  icon on the system tray, or right-click the icon to select Open 

Wrapsody File Manager.  

4.3.1. Documents 

Click the Document  icon within the Wrapsody File Manager. Document allows you to see all the files for 

which you have permission. 

❶ Clicking Show Filter shows various filters for locating a file. Choose whether the file is viewed by you, what 

types of permission you have for the file, file formats, or periods. You can also enter a file name or tag. If you 

select the Plain files only option in File format, the search will be limited to plain files located within Wrapsody 

Drive. 

 
❷ When you slide the toggle switch to the right to activate Hidden files only, it will display files that have 

been hidden using the Hide File feature.  
❸ When you hover over a file, a checkbox will appear on the left side. To access the ❹ icon menu with file 

usage and management features, simply check the box located above the File name heading. Click each icon to 

use the Download, Star, Unstar, Hide File, Move to Recycle Bin features for the file. See the table below for 

each feature. 

Menu Item Description 

❶ 

❷ 

❸ 

❹ 

❺ 

❻ 
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 Download Download the Wrapsody file to your PC. 

 Starred 
Store files you frequently use or plan to access soon. You can access 
the files easily and quickly on the Starred tab in Wrapsody Web 
whenever you need them later. 

 
Remove from the 

Starred list 
Remove the file from the Starred list. 

 Hide File 
Click the icon to hide the file. When you slide the Hidden files only 
toggle switch to the right located at the top right corner, it will 
display files that you have hidden. 

 
Move to Recycle 

Bin 
Delete the file from the Wrapsody Server. It is enabled only when 
you are the file owner. 

❺ Clicking the More  icon in the list of files shows file usage and management menu including Preview, 

Download, Details, Move to Recycle Bin, alongside the file’s thumbnail. Move to Recycle Bin is shown only 

when the file is saved on the PC. See the table below for each feature. 

Menu Item Description 

 Preview View the file in a Preview window without downloading it to the PC. 

 Download Download the Wrapsody file to your PC. 

 Details 

Check the details of the Wrapsody file, including the options 
available in the file management menu. You can check the list of 
users who have permissions for the file and configure user 
permissions and tags (See Details). 

 
Move to Recycle 

Bin 

Delete the file from the Wrapsody Server. If there is the redundant 
file on your PC, the file will also be deleted from your PC. It is 
enabled only when you are the file owner and have the file on your 
PC. 

 
Plain Document 

History 

This feature is only available for plain files located in Wrapsody Drive. 
You can review the version creation history of plain files and 
download the file corresponding to each version. 

❻ Out of all files, files saved on your PC show this  icon under the Local file heading. If you click the 

downward arrow to the right of the icon, the information of the local file including its version, last update 

time, modifier, and local path. Clicking the More  icon located on the far right of the row will display the 

file usage menu as below. 
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See the table below for features provided by each menu. 

Menu Item Description 

 Open Open the latest version of the file on the PC. 

 Open Local File Open the version of the file saved on the PC. 

 Details 
Check the details of the file saved on the PC. You can configure user 
permissions and tags, and use and manage the file (See Details). 

 Update 
The fill will be updated to the latest if the file is not the latest 
version. 

 Export Original 
Unwrap a Wrapsody file to save its original file separately (See Export 
Original). 

 Open Folder Open the folder where the file is saved. 

 Document Chat 
Chat with users who have View/Revise permission for the Wrapsody 
file. The feature is exclusively supported in cases where Fireside is 
installed. 

4.3.2. My PC 

Click the My PC  icon within the Wrapsody File Manager. My PC shows a list of files that you have accessed, 

among all Wrapsody files stored on the PC. 

 
❶ Enter a keyword into the Search box to find files. You can also adjust extra settings by clicking the Filter

 icon on the right.  

❷ It shows the number and storage space of recently used files. 

❸ Refresh the list.   

❹ File icon, file name, version, last update date, file owner and location are displayed on the search result 

list. 

❺ Clicking More  icon on the right side will open the context menu to utilize and manage the local file. See 

the table below for features provided by each menu. 

Menu Item Description 

 Open Open the latest version of the file in an application. 

 Open Local File Open the version of the file stored on the PC. 

❶ 
❷ 

❸ 

❹ 

❺ 
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Manage 

Wrapsody File 
It opens the Details window for the file. You can configure user 
permissions and tags, and use and manage the file (See Details). 

 Update 
The fill will be updated to the latest if the file is not the latest 
version. 

 Export Original 
Unwrap a Wrapsody file to save its original file separately (See 
Export Original). 

 Open Folder Open the folder where the local file is saved. 

 Document Chat 
Chat with users who have View/Revise permissions for the 
Wrapsody file. The feature is exclusively supported in cases where 
Fireside is installed. 

 Check in 
It is only enabled when the file is on hold for check-in. Select the 
option to update the file on hold as the latest version (See Hold 
Check in). 

4.3.3. Smart Cleaner 

Click the Smart Cleaner  icon within the Wrapsody File Manager. You can view the list of duplicate or 

obsolete Wrapsody files stored on your PC that are the target of cleanup. You have the option to either delete 

these files or mark them as exceptions to keep them from being cleaned up.  

 
❶ The Duplicate files tab shows a list of files that share identical file info or have the same file ID.  

❷ The Obsolete tab shows a list of unused files for specific periods (3 months).  

❸ The Deleted tab shows a list of Wrapsody files deleted from the server. You can select files from the list 

and remove those that have already been deleted from the server and no longer exist there.  

❹ The Exempted tab shows a list of files that have been exempted from the Duplicate or Obsolete tab.  

❺ It is displayed in the form of “Storage space of ROT files/Percentage of ROT files compared to the total 

files (number of ROT files/number of total files)”.   

❻ Either in the Duplicate files or Obsolete tab, choose files by checking their corresponding boxes on the left 

side. Then click the Exempt button located at the top right to remove them from the list of ROT files. 

❼ Either in the Duplicate files or Obsolete tab, choose files by checking their corresponding boxes on the left 

side. Then click the Delete button located at the top right to delete the ROT files.    

❽ Refresh the list. 

❶ ❷ ❸ ❹ 

❺ 
❻ ❼ ❽ 



 

Wrapsody Cloud v5.9.2 User Guide | Page 51 

4.3.4. Settings 

Go to Settings  at the bottom left corner in the Wrapsody File Manager and configure the settings to use 

Wrapsody. 

General 

1. Click the Settings tab.  

2. Refer to the following content for instructions on configuring each option. 

 
❶ Version Information 

If the Wrapsody Client installed on your PC is not the latest version, the Update button is enabled for the 

user to update the file to the latest version.  

❷ General 

 Set to allow all users to view at creation: If the toggle is switched on, it will be set to allow all 

the users to view the Wrapsody file when you create. 

 Allow me to directly check out my own documents: Configure the file to open in Revise mode 

instead of View mode if you have the exclusive permission to access it. However, according to 

the company policy established by the administrator, this option may not be visible. 

 Check in automatically when closing documents: Configure the file to be checked in 

automatically upon closure after saving changes in Revise mode, without prompting a check-in 

confirmation dialog box. 

 Show real-time messages on the system tray: If the toggle is switched on, real-time notification 

alerts for viewing, revising, or commenting will be displayed in the system tray. You can set the 

notification types by file on the Manage Wrapsody File window (See Details > ❻, ❼ Receive 

notifications). 

 Show notifications for holding check-outs in: If you delay the check-in for a file after checking it 

in, a notification will be sent to remind you to complete the check in. You can set the specific 

time (in minutes) after which these notifications will be sent. Enter the number of minutes after 

which you would like the notifications to be sent following your most recent use of the file.  

 Show notifications for: Specify the duration (in seconds) to display notification and push 

messages on the screen. Enter the number of seconds after which you would like the 

notifications to disappear from the screen. 

Quick Menu  

1. Go to the Wrapsody - Quick Menu tab.  

❶ 

❷ 
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2. In the Edit Quick Menu section, turn on the toggle of Sync quick menu with server to apply the settings 

defined by the Wrapsody administrator. 

3. If you prefer to customize the options, select the checkboxes for each item listed under Items. These 

selections will then appear in the Quick Menu. 

 
4. The checked options are shown when you right-click a Wrapsody file and choose Wrapsody - Quick Menu 

as in the image below. See the description below for features provided by each menu item. 

 
 Set users: Designates users who can either view or revise the Wrapsody file (See Set Users). 

 Set tags: Set tags for the Wrapsody file (See Set Tags). 

 Create Branch: Creates a branch file for the Wrapsody file. 

 Create Link: A sharable link for downloading the file will be created, enabling you to share it with 

other users. 
 Change Server File Name: Overwrite the file name on the server with the file name saved on your 

local PC. 

 Export Original: Unwrap the Wrapsody file to create a plain file. 

 Timeline: Displays the history of usage and management for all versions of the Wrapsody file. You can 

select a less frequently used version out of the previous versions and delete it from the server. You 

can access both the Usage Map and Branch Map for the file here (See Timeline features). 

 Preview: Opens the file in a Preview window without downloading it to the PC. 

 Document Chat: Chat with users who have View/Revise permissions for the Wrapsody file. The 

feature is exclusively supported in cases where Fireside is installed. 

Backup files 

In case that Wrapsody files are lost or have to be transferred to a new device, export the file list containing 

information about Wrapsody files stored on your PC as a file. 
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1. Go to the Backup/Restore documents tab.

 
2. Click Save to local computer or Save to server to save a backup file list for restoration. 

Restore files 

You can restore the Wrapsody files to a specific location on your PC using the Wrapsody backup file. Follow the 

procedures below to restore the Wrapsody files. 

1. Go to the Backup/Restore documents tab.  

2. Click the Restore button. 

3. When a dialog box below appears, specify the details needed for restoration. 

 
❶ Import a backup file list to be used for restoration. Prior to using this restoration feature, it is 

recommended to perform a backup in order to generate a backup file. 

❷ Specify a location where the restored files will be saved. To save the restored files in their original 

location, select Original location. Or to save the restored files in a specific location, select Specified 

location and enter the path.  

❸ Select the option of how you want to deal with the original files when they still remain in the original 

location in the case you have selected Original location at ❷. If you do not want to back up the 

remaining original files and overwrite them with the backup files, select Overwrite. To back up the 

remaining original files all together in a particular location, select Move the original files to and specify 

the path. Select Add ‘.BAK’ to the original file name to distinguish between the remaining original files 

❶ 

❷ 

❸ 
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and those set for restoration in the same location. The remaining files will remain in their current location, 

with'.BAK' added as a suffix to each file name.  

4. When all the settings are done, click OK. 

 

5. The Wrapsody File Restorer window appears as below. Click the ❶  icon to restore the files one by 

one, or click ❷Restore All to restore all the files at once. 

Specify a download path 

Specify the default path for saving a Wrapsody file downloaded from the server. 

1. Go to the Backup/Restore documents tab. 

2. Click Modify in the Download section to specify a path for downloading a Wrapsody file and click OK. 

3. When the dialog indicating the path change appears, click OK.  

❶ 

❷ 
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4.4. Settings 
You can configure the settings to use Wrapsody. The Settings page in the Wrapsody Client context menu is the 

same as Settings found in the Wrapsody File Manager. See Wrapsody File Manager > Settings for more 

information. 

4.5. Offline mode 
You can continue to work on Wrapsody files even when switching from online to offline or when the online 

environment is not available due to some network issues. The changes will be automatically updated to the 

server when you go online later.    

When you run Wrapsody Client , the text displayed in the title bar includes “(Offline)” at the end and the 

color of the title bar turns grey. 

 

4.5.1. Create a Wrapsody file when offline 

If you create and save a new Wrapsody file in offline mode, the file is uploaded to the server once it switches 

from offline to online. 

1. Save a new file on the PC and close the file. 

2. Right-click the file and select Create Wrapsody File. 

3. Click Wrap at the bottom of the Create Wrapsody File window. Setting users or tags are not available 

within the Create Wrapsody File window, but required tags are automatically populated. 

4. The creation of a Wrapsody file is completed. 

5. The file will be automatically uploaded to the server as an initial version when it switches to online. 
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4.5.2. Edit a Wrapsody file when offline 

The users can view or review files offline when they have the corresponding permissions. Revisions made 

offline will be automatically uploaded to the server once it goes back online. 

Note: In offline mode, you can access only the files that have been utilized on the PC or personally 

downloaded from the Wrapsody Client. Files downloaded through Outlook email or web browsers cannot be 

used in offline mode. 

Follow the procedures to update files edited online to the server.  

1. Open a Wrapsody file when offline.   

2. The file is opened in View or Revise mode according to the permission the user has.  

3. Edit and save the file.   

Note: If the mode goes back to online while a file is being edited, a dialog box appears upon closing the 

file. This dialog box offers the options to check in, hold the check-in, or cancel the check-in upon file 

closing. You can choose either Check in, Not now, or Cancel.  

4. If the mode switches back to online after the file is closed, the file edited offline is automatically updated 

to the server as the latest version.  

4.5.3. Handle a conflict 

Wrapsody files revised offline will be attempted to be updated to the server whenever: 

 When switching from offline to online 

 When opening the file while online 

 When closing the file while online 

However, if the attempt to update the changes to the server fails due to a conflict, such as another user having 

already created a newer version, a confirmation dialog box will appear to ask whether to create a branch file 

or not.   

 When you select Yes: The file saved offline will be managed as a separate branch file.  

 When you select No: The file will be only saved on the PC. Subsequently, a message will appear when 

you open and close the file, asking “Do you want to create a branch document?”.   
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5. Wrapsody Web 

Wrapsody provides users with the convenience of managing their files on the Wrapsody Server through the 

web interface. To access Wrapsody Web, right-click the Wrapsody  icon on the system tray and select Open 

Wrapsody Server Website. Here’s an overview of the Wrapsody Web interface. 

  
❶ Home: Files related to organizational notices, ROT versions and files, recently viewed files, starred files are 

displayed.  

❷ Search: The user can search for all Wrapsody files on the server using the Search bar. 

❸ All files: You can locate and manage not only all the files on the server for which you have permission but 

also those stored in Wrapsody Drive. Each tab showcases the list of recently checked-in files, starred files, files 

for which you have received View alerts and files moved to the Recycle bin. 

❹ Manage: In Smart Cleaner, you can manage ROT files, whereas in Request, you can review the history of 

received requests. The Log section provides you with the history of file usage, analytics, and more. 

❺ Chat: Connected with Fireside, chatting services are provided. 

❻ Notification: It provides a list of Wrapsody notifications that the user has received.  

❼ User Info: It displays user details like name, group affiliation, title, phone number, and email. You can also 

access Preferences and Logout from here. 

  

❶ 

❷ 

❸ 

❹ 

❺ ❻ ❼ 
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5.1. Home 
The Home section offers users a quick overview of files associated with organizational notices, recently viewed 

files, starred files, and more. Users can check the ratio of ROT files, recent tags, frequently used files.  

 

For the description of each item, see the table below. 

Item Description 

Files associated with 

organizational notices Files shared across organization-wide for notifications 

Smart Cleaner 

Target 

version 

Ratio of ROT versions compared to the total versions of your 
owned files 

*ROT file: Files that are redundant, obsolete, or trivial. 

Total target 

files 
The number of ROT files or files with ROT versions among your 
owned files 

Obsolete Files that have not been used over a year or files with versions 
that have not been used over a year among your owned files 

Similar Files that originate from another file and share the same content 
with it 

Recent Files The list of files for which the user has recently received View or 
Revise permission 

Starred Files 
The list of files that you have starred. 

Recent Tags Tags that have been used twice or more among recently created 
tags 

Frequently Used Tags Tags that have been used most frequently in the past three days, 
excluding required tags 
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5.1.1. Preferences 

To streamline the process of checking and previewing file lists, click on your profile icon in the top-right corner 

and choose Preferences from the menu. The settings window will then appear.

 
 Default list count: Click the dropdown icon to select the number of files to be displayed per page on 

Wrapsody Web. This default count applies to all sections, including Document and Starred. While you can 

still adjust the list count for each section at the top right of the page, it will revert to the default count 

upon page refresh. 

 Open preview in: Choose whether to open the preview on the web in a new window or a new tab. This 

selection does not affect cases where you are previewing a file by selecting it on your PC or Wrapsody 

Drive for Desktop. 

 Action upon clicking: Select whether a file automatically opens after being downloaded when you click its 

name on the web. Note that even if you choose the Download and open a file option, the file may not 

open after being downloaded if the Wrapsody Client or a supported application is not installed. 

 Click the Save button to apply the settings, and the settings window will close. 

Note: The settings will take effect immediately upon clicking the Save button. However, depending on your 

browser settings, they may apply after the next login. 

5.1.2. Log out 

To log out, click your profile icon in the top-right corner, select Logout, and you will be immediately taken to 

the login page. You can then log in with another user account on the web. Keep in mind that logging out from 

the web interface does not automatically log you out from the Wrapsody Client. 

5.2. Search Box 

5.2.1. Search for files 

Note: You can search for all Wrapsody files saved on the server, including plain files on Wrapsody Drive, using 

the search bar at the top of the web page. The results will show only the latest versions. To download previous 

versions, locate the final version of the file and download the desired version in the Timeline window. See 

Timeline features for more detailed information. 

1. Enter a search term in the search bar at the top of the screen and press the Enter key. For a more detailed 

search, click on Advanced Search at the top. Once the advanced search filters appear, select options for 

each item or enter search terms, and click on Search (multiple selections and inputs allowed). 
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 Is Opened: You can choose whether a file has been opened or unopened. Please note that 

 is disabled when you choose any of the Is Opened options. 

 My permission: You can multi-select whether the file is owned by you and whether you have Revise 

or View permission for the file. 

 File format: You can multi-select file formats including Word, Excel, PowerPoint, PDF, Hangeul, 

Notepad or other formats excluding the preceding six. If the  option is selected, the 

search will be limited to plain files located in Wrapsody Drive with the chosen extensions. 

 Period: Time elapsed since the last revision. Choose from options such as Last 1 month, Last 3 

months, Last 6 months, Last 1 year, or Select Custom period to set a custom time frame. 

 Items for manual input: Enter search terms in the text area of File name, Word in content, Exclude 

from result, Tag and click  to add multiple search terms. You can also input names of Owner and 

Modifier manually. 

2. If each of File name, Word in content, Tag, Owner and Modifier contain search terms you entered, the 

search results will appear by each corresponding item.

 
3. To perform an advanced search within each search result created for individual items, click Advanced 

Search located at the bottom of each result list. 

Note: Icons displayed to the left of the file icon indicate the current status of file usage. 
 The file has been revised and updated by another user but not viewed by you. 

 The file has been checked out and is being edited by another user. 
 You received View alerts for the file but you have not viewed it yet. 

Icons displayed under the My permission heading indicate that your permission for the file. 

 You have View permission for the file. 

 You have Revise permission for the file. 

 You have no permission for the file. 

4. Select the checkboxes of files to use or manage. Just above the File name heading, an icon menu will 

appear, along with the count of selected files. Alternatively, you can hover over a file and click the More

 icon on the far right to choose the desired options. For instructions of each option, see Documents. 

5.2.2. AI-powered search 
Note: Please contact your Wrapsody administrator to utilize this feature. 

You can find the desired files from the Wrapsody server using AI-powered search. By entering content in 

sentence form, including keywords, you can obtain more relevant search results. 

AI-powered search 

1. Access the Wrapsody website. 

2. Click on the AI Search button  in the top search bar. 
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3. The search bar will switch to the AI-powered search mode. 

4. Enter the content including keywords and press Enter. 

5. Highly relevant files will appear in the search results. 

 
Note: Content related to the search term will appear below the file name. Clicking on the content will open a 

window where you can view the associated content in its entirety. 

AI-powered search using Advanced Search 

1. Access the Wrapsody website. 

2. Click on the AI Search button  in the top search bar. 

3. The search bar will switch to the AI-powered search mode. 

4. Enter the content including keywords and press Enter. 

5. Highly relevant files will appear in the search results. 

 
6. Select the desired file type under File format and specify the time period for the last update under Period. 

Enter the content to be included in or excluded from the file name in the File name and Exclude from 

result sections, respectively. Add tag information under Tag. 

 
7. Click on Search. 

8. The search results that meet the criteria will be displayed. 

5.3. Document Sections and File Management 
Sections like Documents, Wrapsody Drive, Recent, Starred, Received View Alerts, and Recycle Bin offer you 

file usage and management features. You can manage files individually or by folder. 
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For the description of items or sub items, see the table below.  

Item Description 

Documents The list of all files for which the user have permission for among all 
the files saved on the server 

Wrapsody 

Drive 

Personal 
Virtual drive for managing the user’s personal files.  

Group 
Virtual drive for managing files owned by the user's group.  

Company 
Virtual drive for managing files owned by the user's company. 

Recent 
The list of files updated recently among the files for which the 
logged-in user has permission However, files that are accessible to all 
users will not appear in the Recent section, even if updates occur. 

Starred 
The list of files that you have starred. 

Received View Alerts 
The list of files that you have received view alerts for. 

Recycle Bin 
The list of files that have been deleted and moved to Recycle Bin 
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5.3.1. Documents 

You can locate all files for which you have permission and access and manage these files using the provided 

features. 

 

Top icon menu 

Choose the checkboxes to the left of the file icons to select files for use or management. Just above the File 

name heading, an icon menu will be enabled. Click each button to use your desired feature for the file. 

Menu Item Description 

 Download Download the Wrapsody file to your PC. 

 Change owner 
Transfer the file ownership to another user. It is enabled only when you 
are the file owner. 

 Star 
Store files you frequently use or plan to access soon. You can access the 
files easily and quickly on the Starred tab on Wrapsody Web whenever 
you need them later. 

 
Remove from the 

Starred list 
Remove the file from the Starred list. 

 Request Request permission or desired actions for the file. 

 Hide File 
Click the icon to hide the file. When you slide the Hidden files only toggle 
switch to the right located at the top right corner, it will display files that 
you have hidden. 

 
AI Document 

Helper 
AI Document Helper analyzes Wrapsody files and Wrapsody Drive files 
based on AI technology. 

 
Move to Recycle 

Bin 
Delete the file from the Wrapsody Server. It is enabled only when you are 
the file owner. 
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Download a file 

1. Choose the checkboxes to the left of the files you wish to download. 

2. To download multiple files, click the Download  icon at the top. Alternatively, you can click the More

 icon at the far right and select Download to download individual files. 

3.  The file will be downloaded to the PC. 

Change the owner 

The action is applicable only when the currently logged-in user is the file owner. Select files you own and 

change the owner to another user. 

1. Choose the checkboxes to the left of the files for which you want to change the owner. 

2. When you click the Change owner  icon above the File name heading, the Change owner window will 

appear. 

3. Select a user from the organization chart or search for a user name or ID using the search bar, and click 

OK.  

4. The selected user will become the file owner.  

Add to/Remove from the Starred list 

1. Choose the checkboxes to the left of the files you want to add to or remove from the Starred list. 

2. To add a file to the Starred list, click the Star  icon located in the top icon menu. To remove from the 

list, click the Unstar  icon. 

3. The selected files will be added to or removed from the Starred list. 

Request for permission or actions 

1. Choose the checkboxes to the left of the files you wish to download. 

2. Click the downward arrow to the right of the enabled Request  icon located above the File name 

heading. Select a request type (Revise permission, View permission, Transfer File Ownership, End 

Editing) from the context menu. Alternatively, you can click the More  icon to the far right to select 

Request and choose a request type. 

3. Enter a reason for the request and click OK. 

Hide File 

1. Choose the checkboxes to the left of the files you wish to download. 

2. Click the enabled Hide File  icon located above the File name heading. This action will hide the 

selected files. 

3. When you slide the Hidden files only toggle switch to the right located at the top right corner, it will 

display files that you have hidden. 

Move to Recycle Bin 

The action is applicable only when the currently logged-in user is the file owner. Select files that you own and 

utilize the feature.    

1. Choose the checkboxes to the left of the files you wish to download. 

2. Click the enabled Move to Recycle Bin  icon located above the File name heading. 

3. When the dialog box indicating that the file has been deleted appears, click the OK button.  

4. The selected files will be relocated to the Recycle Bin.  

5. Files stored in the Recycle Bin will be automatically deleted after a specific duration. The duration varies 

based on the server settings.  
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Restore from Recycle Bin 

See Recycle Bin > Restore from Recycle Bin. 

Additional menu 

Apart from the icon menu that appears at the top, an additional menu under the Owner heading becomes 

activated when you hover over a file. See the table below for a description of options displayed based on your 

permissions. 

Permission Item Description 

View or higher 

Preview 
Opens the file in a Preview window without downloading 
it to the PC. 

Download Download the Wrapsody file to your PC. 

Details Check the details of the Wrapsody file. 

Timeline 
Manage Wrapsody files by version. You can also access 
both the Usage Map and Branch Map for the file here. 

Request 
Request permission or desired actions for the Wrapsody 
file. 

Create link Create a link to share the Wrapsody file with other users. 

Document Chat 
Chat with users who have View/Revise permission for the 
Wrapsody file. The feature is exclusively supported in 
cases where Fireside is installed. 

Revise or higher 

Change Server File 
Name 

Change the name of the Wrapsody file on the server. 

Check out 
Edit the file in the web interface without downloading it to 
the PC. It is active only when the web Office features are 
connected. 

File ownership 

Move to Recycle 
Bin 

Delete the file from the Wrapsody Server. It is enabled only 
when you are the file owner. 

Request 
Permanent Delete 

When the request is approved, the Wrapsody file will be 
deleted permanently. 
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Preview 

1. When the mouse hovers over a file, a menu set appears in the Owner column. 

2. Click the Preview  icon. 

3. You can view the file on the Preview window.  

 

4. Click the Expand button  in the right sidebar menu to view detailed information about the file. You can 

utilize the Version History  and AI Document Helper  features by clicking on the icons. 

 

Download a file 

1. When the mouse hovers over a file, the More  icon appears on the far right side. 

2. Click the More icon and select Download. 

3. The file will be downloaded to the PC. 
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Details 

This provides both file info and file management capabilities. The information presented is identical to that 

from the Wrapsody Client, but the displayed icons may vary based on your permissions for the file. For a 

detailed description of the window display and provided features, refer to Details. Additionally, find 

instructions on setting permissions for users in the Set Users section. 

1. When you hover over a Wrapsody file or a plain file, a menu set appears on the right side. 

2. Click the Details  icon, and a Details window will appear. 

Timeline 

1. When you hover over a file, a menu set appears in the Owner column. 

2. Click the More  icon and select Timeline. 

3. A Timeline window appears as below. (See Timeline and Timeline features for the description of items and 

the provided features.) 

 

Request for permission or actions 

1. When the mouse hovers over a file for which you want to request usage permission or actions, a menu set 

appears in the Owner column. 

2. Click the More  icon and select Request. 

3. When a Request window appears, select a request type (Revise permission, View permission, Transfer 

File Ownership, End Editing) and enter a reason for the request. 

 
4. Click OK. 
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Create a sharable link 

1. When the mouse hovers over a file that you want to share with other users, a menu set appears in the 

Owner column. 

2. Click the Create Link  icon at the top. 

3. The link will be copied to the clipboard. 

Change a server file name 

1. When the mouse hovers over a file for which you want to change the name, a menu set appears in the 

Owner column. 

2. Click the More  icon and select Change Server File Name. 

3. A Change Server File Name window appears. 

 
4. Enter the name you wish to change to and then click OK. 

Document Chat 

1. When the mouse hovers over a file for which you want to initiate a chat, a menu set appears in the Owner 

column. 

2. Click the More  icon and select Document Chat. 

3. A chat room opens with the file name as the title. 

 
4. Enter a message you want to send and press the Enter key. 

Move to Recycle Bin 

1. When the mouse hovers over a file that you want to move to the Recycle Bin, a menu set appears in the 

Owner column. 

2. Click the More  icon and select Move to Recycle Bin. 

3. When a confirmation dialog box for deletion appears, click Delete. 
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Request permanent deletion 

1. When the mouse hovers over a file that you want to delete permanently, a menu set appears in the 

Owner column. 

2. Click the More  icon and select Request Permanent Delete. 

3. When a Request Permanent Delete window appears, enter a reason for the request.

 
4. Click OK. 

Check out on the web 

1. When the mouse hovers over a file that you want to check out on Wrapsody Web, a menu set appears in 

the Owner column. 

2. Click the More  icon and select Check out. 

Note: The Check out menu is enabled only when the user has Revise permissions for the file. If the file has 

been checked out on the PC, the Check out button on the web will be deactivated and invisible. 

3. Click the  button centered on the right side to access the Details, Version History, and Document Chat 

tabs.  

4. Finish editing the file and close the web browser. If multiple users have checked out the file on the web, 

the file will be checked out with the most recent edits.  

Note: If a file is currently being edited on the web by other users, you have the option to request the file 

owner for End Editing. Conversely, if a user is editing a file and the owner ends the editing, the changes might 

not be applied automatically. 

5.3.2. Wrapsody Drive Web 

Wrapsody Drive Web is a virtual folder system available through the web interface, providing an efficient way 

to organize and manage Wrapsody Drive files. It synchronizes in real time with Wrapsody Drive and Wrapsody 

Drive for Desktop, ensuring that your Wrapsody Drive files stay up-to-date across all platforms where you 

access and manage them. 
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Wrapsody Drive structure 

 Personal Drive: File management space for the user’s files. It is displayed in the form of User name (User 

ID) such as Fasoo Kim (fasoo.kim) for example. 

 Group Drive: File management space for files owned by the user's group. It is displayed in the form of the 

team name or the group name. All members in the same group can access the Group drive, but sub-

folders can be accessed according to the permission that each user has. 

 Company Drive: File management space for files owned by the user's company. All members in the same 

company can access the Company drive, but sub-folders can be accessed according to the permission that 

each user has. 

 My Group: If the user holds the position of a direct manager of a group or a higher-level role, they will be 

granted View permissions for the folders within the Group drive. Even if the manager lacks permission for 

a specific folder, they can still access and view the group files via the My Group drive. They can also 

request Revise permissions for sub-folders within group folders when necessary. The user's group drive is 

shown in the My Group drive, but its sub-folders will not be displayed there. To check the sub-folders, the 

manager needs to navigate to the group drive itself. 

 

Wrapsody Drive Usage  

You can track the storage status and daily storage usage of Wrapsody Drive for each company, group, and 

personal drive. 

 
 Company/Group/Personal Drive Storage 
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Displays capacity information, including allocated space and current usage (total size of latest file versions), for 

the selected drive. It also shows the total size of all versions of each file. 

 Daily storage usage 

Graphically represents the daily storage usage of the selected drive. You can click on the bar graph icon  or 

line graph icon  to view the data in the desired graph type. Additionally, you can select the time period for 

drive usage, making it simple to view data for that time. 

Follow these steps to check the usage status of each drive. 

Check company drive usage 

1. Access the Wrapsody website. 

2. Click Drive Usage from the left pane. 

3. Right-click Company Drive. 

4. Click Drive Usage. 

5. Check the current company drive usage. 

Check group drive usage 

1. Access the Wrapsody website. 

2. Click Drive Usage from the left pane. 

3. Right-click the group drive tab, labeled with your group name. 

4. Click Drive Usage. 

5. Check the usage status of your group drive. 

Check personal drive usage 

1. Access the Wrapsody website. 

2. Click Drive Usage from the left pane. 

3. Right-click on the personal drive tab, labeled with your user name (ID). 

4. Click Drive Usage. 

5. Check the usage status of your personal drive. 

Top icon menu 

Choose the checkboxes to the left of the file icons to select files for use or management. Just above the Name 

heading, an icon menu set will be enabled. This menu is visible to all, regardless of their permissions for the 

file. Click each button to use your desired feature for the file. See Documents > Top icon menu for a more 

detailed description of each feature. 

Menu Item Description 

 Download Download the Wrapsody file to your PC. 

 
Move to Recycle 

Bin 

Delete the file from the Wrapsody Server. This automatically transfers it to the 
Recycle Bin of the file owner and syncs with Wrapsody Drive, swiftly removing 
the file from your Wrapsody Drive for Desktop as well. 

 Star 
Store files you frequently use or plan to access soon. You can access the files 
easily and quickly on the Starred tab on Wrapsody Web whenever you need them 
later. 

 Unstar Remove the file from the Starred list. 

 
AI Document 

Helper 
AI Document Helper analyzes Wrapsody files and Wrapsody Drive files based 
on AI technology. 

 Request Request permission or desired actions for the file. 
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Additional menu 

In addition to the icon menu at the top, an additional menu under the Owner heading becomes active when 

you hover over a file. Refer to the table below for a description of options displayed based on your 

permissions. For more detailed information on each feature, please see Documents > Additional menu.  

 Item Description 

View or higher 

Preview 
Opens the file in a Preview window without downloading it to the 
PC. 

Download Download the Wrapsody file to your PC. 

Details 

Check the details of the Wrapsody file, including the options 
available in the file management menu. You can check the list of 
users who have permissions for the file and configure user 
permissions and tags. 

Timeline 
Manage Wrapsody files by version. You can also access both the 
Usage Map and Branch Map for the file here. 

Request Request permission or desired actions for the Wrapsody file. 

Create link Create a link to share the Wrapsody file with other users. 

Document Chat 
Chat with users who have View/Revise permissions for the Wrapsody 
file. The feature is exclusively supported in cases where Fireside is 
installed. 

Revise or higher 

Change Server File 
Name 

Change the name of the Wrapsody file on the server, and it will 
seamlessly synchronize in real time with Wrapsody Drive, 
immediately displaying the new name on your Wrapsody Drive for 
Desktop. 

Check out 
Edit the file directly in the web interface without downloading it to 
your PC. This feature is available only when the web Office features 
are connected and in compliance with company policies. 

Move to Recycle 
Bin 

Delete the file from the Wrapsody Server. This automatically 
transfers it to the Recycle Bin of the file owner and syncs with 
Wrapsody Drive, swiftly removing the file from your Wrapsody Drive 
for Desktop as well. 

File ownership 
Request 

Permanent Delete 
When the request is approved, the Wrapsody file will be deleted 
permanently. 

Details 

Examine the details of a Wrapsody Drive file on Wrapsody Web. In terms of path information, the Details 

window, accessed through the steps listed below, will exclusively show the path in Wrapsody Drive, even if the 

file has another path on the user’s PC. 

1. Click on Wrapsody Drive in Wrapsody Web. 

2. Select the Personal, Group or Company Drive tab and go to a folder containing a file you wish to inspect. 

3. Hover over a file, and the Details  icon will be activated on the right side.  

4. Click the icon to reveal the Details window. For a description of each item in the Details window, see  

Details. 

Check permissions for a plain file 

The permissions for a plain file within Wrapsody Drive can be inspected only through the following steps 

within Wrapsody Web. 

1. Click on Wrapsody Drive in Wrapsody Web. 

2. Select the Personal, Group or Company Drive tab and go to a path containing the file you wish to inspect. 

3. Hover over the file, and the Details  icon will be activated on the right side.  

4. Click the icon to reveal the Details window, where you can view users with Revise or View permissions. 
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5. Click Set User to access the Set User window as shown below. 

 
6. To check permissions for a folder containing the plain file, observe the users listed below the users with 

permissions for the file on the right. 

Move to Recycle Bin 

To delete a file in the Wrapsody Drive section on Wrapsody Web, follow these steps. The deleted file will be 

relocated to the Recycle Bin of the file owner on the server, which is accessible on Wrapsody Web, and it will 

simultaneously disappear from your Wrapsody Drive for Desktop. If you have Write permission for the folder 

containing the file, you can delete it, even if you are not the file owner. However, please be aware that the file 

will move to the Recycle Bin for the file owner. Once the file is moved to the Recycle Bin, the file's permissions 

inherited from the folder will be reset. 

1. Click on Wrapsody Drive in Wrapsody Web. 

2. Select the Personal, Group or Company Drive tab and go to a path containing the file you wish to delete. 

3. Select the checkbox of the file, then click the Move to Recycle Bin  icon that appears at the top. 

Alternatively, hover over a file, then click the More  icon activated on the right side and select Move to 

Recycle Bin. 

4. When a confirmation dialog box for deletion appears, click Delete. 
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5. The file will disappear, being transferred to the Recycle Bin of the file owner on the server. To restore the 

file, refer to Restore from Recycle Bin and Restore a Wrapsody Drive file. 

Folder management features 

If you hover over a folder, the More  icon will be enabled. 

 

Folder details 

1. Select the Wrapsody Drive tab. 

2. Select the Personal, Group or Company Drive tab and hover over a folder. 

3. Click the Details  icon activated on the right side of the folder.  

4. A Details window appears. For a detailed description of items in a folder's Details window, refer to Details. 

 

Search files or folders  

1. Select the Wrapsody Drive tab. 

2. Select the Personal, Group or Company Drive tab. 

3. Click Show Filter at the top right. 
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4. Enter a folder or file name in the search box. 

5. Search results will be displayed, including both folders and files that contain the entered input. 

 

Create, delete or rename a folder  

1. Select the Wrapsody Drive tab. 

2. Select the Personal, Group or Company Drive tab and hover over a folder. 

3. Click an option from the enabled menu on the far right side of the folder to perform following features.  

 Add: Add a new folder under the selected folder.  

 Change folder name: Rename the selected folder.  

 Delete folder: Delete the selected folder.  

Change permissions for a folder 

1. Select the Wrapsody Drive tab. 

2. Select the Personal, Group or Company Drive tab and hover over a folder. 

Note: A user can change permissions only for folders for which the user has Write permission. 

3. Click the More  icon activated on the right side of the folder. 

4. Click Set User. 

5. Select the checkboxes on the right side of a group or user for which you intend to change permissions. 

6. In the right pane, choose permissions you wish to grant (Read or Write) by turning on the toggle button 

for a user or a group. 
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7. Click Apply to grant permissions for the selected user or group.  

Restore a Wrapsody Drive file 

A deleted Wrapsody Drive file can be restored to its original folder. 

1. Select the Wrapsody Drive tab. 

2. Select the Personal, Group or Company Drive tab and hover over a folder. 

3. Click the Details  icon activated on the right side of the folder, and the Details window will appear. 

4. Click the Timeline  icon. 

5. In the box indicating file deletion within the folder usage history, click the Restore button, and the 

corresponding file will be restored to its original folder. 

 

5.3.3. Recent 

The list of recently checked-in files among the files for which the logged-in user has permission. However, files 

that are accessible to all users will not appear in the Recent section, even if updates occur. For information 

about icon and additional menu, see Document Sections and File Management > Documents.   
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5.3.4. Starred 

A list of files added to Starred will be displayed. For information about icon and additional menu, see 

Document Sections and File Management > Documents.  
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5.3.5. Received View Alerts 

A list of files for which other users have requested your viewing will be displayed 

1. Go to Received View Alerts. 

2. Click  located at the top right. This action will activate search filters, enabling you to perform a 

detailed search.  

 
3. Based on the selections you make for My Permission and File Format, along with your input for File Name, 

a list of View Requests will be shown. 

4. Check the checkboxes of each item on the list and click Move to Recycle Bin on the top right to delete the 

View requests. 

5.3.6. Recycle Bin 

A list of files deleted, whether in Wrapsody Web or on Wrapsody Drive for Desktop, will be displayed. You can 

restore files or request permanent deletion for them. 

Review details 

When you select the name of a deleted file in the Recycle Bin, a Details section will emerge on the right, 

providing file details like owner, uploaded date, and last modifier. For Wrapsody Drive files, the previous 

location in Wrapsody Drive before being moved to the Recycle Bin will be indicated under the Location 

heading. 

1. Go to Recycle Bin. 

2. A list of deleted file will be shown. 

3. Click on the file name, and the Details pane will appear on the right. 
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Check version history 

Review details and usage history for each version of a deleted file. 

1. Go to Recycle Bin. 

2. A list of deleted file will be shown. 

3. Click on the file name, and the Details pane will appear on the right. 

4. Click the Version History tab located on the right. 

 

Restore from Recycle Bin 

1. Go to Recycle Bin. 

2. A list of deleted files will be shown. 

3. Choose the checkboxes to the left of the files you wish to restore. 

4. To restore multiple files, click the Restore  icon at the top. Alternatively, for a single file, click the More

 icon at the far right and select Restore. 

5. When a restoration confirmation dialog box appears, click Restore. Upon successful restoration, the file 

will no longer appear in the list. For Wrapsody Drive files, they will be restored to their previous paths in 

Wrapsody Drive for Desktop as well.  
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Restore a Wrapsody Drive file with no original folder 

In situations where the original folder that previously contained a deleted Wrapsody Drive file is no longer 

available, you have two options: either restore the original folder if possible, or alternatively, restore the file to 

a path in your Personal Drive by following the steps below. 

1. Go to Recycle Bin. 

2. A list of deleted files will be shown. 

3. Choose the checkboxes to the left of the files you wish to restore. 

4. To restore multiple files, click the Restore  icon at the top. Alternatively, for a single file, click the More

 icon at the far right and select Restore. 

5. When a restoration confirmation dialog box appears, click Restore. Then the Restore File window will 

appear. 

 
6. Click Next. 

7. Select a folder within your Personal Drive to restore the file to. Then click Apply.

 
8. The file will be restored to the selected path in both Wrapsody Drive Web and Wrapsody Drive for 

Desktop. Note that the file's permissions will inherit from the folder you choose for the new path, while 

still retaining any previously set permissions through the Set Users window (Refer to the Rules of 

permissions granted to Wrapsody Drive files). 

Request permanent deletion 

1. Go to Recycle Bin. 

2. When you hover over a file that you want to delete permanently, a menu set appears on the right. 

3. Click the More  icon and select Request Permanent Delete. 

4. When a Request Permanent Delete window appears, enter a reason for the request. 
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5. Click OK. 

5.3.7. Quick Menu 

A context menu set will appear when you right-click a file in the search results. See Documents > Additional 

menu for a more detailed description of each feature. 

Item Description 

Preview The file will be open in a preview mode within web browser.  

Download The file will be downloaded to the PC. 

Details The details about the file will be displayed (See Details). 

Timeline 
The history of file changes and usage will be displayed in time sequence (See 
Timeline). 

Request You can request Revise or View permission for the file.  

Create link Create a link to share the file with other users.  

Change Server 
File Name 

Change the name of the Wrapsody file on the server. 

Document Chat 
Chat with users who have View/Revise permissions for the Wrapsody file. The 
feature is exclusively supported in cases where Fireside is installed. 

Check out 
The file can be edited in the web interface This feature is visible according to 
administrative rules. 
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5.4. AI Document Helper 
Note: Please contact your Wrapsody administrator to utilize this feature. 

AI Document Helper analyzes Wrapsody files and Wrapsody Drive files based on AI technology. You can freely 

ask questions about files to AI Document Helper and easily get answers. 

AI Document Helper can analyze up to five documents simultaneously. It supports various text files including 

MS Office, Hangul, PDF, and TEXT files. 

Route 1. Document list 

You can utilize the AI Document Helper feature in document lists such as Home, Documents, Wrapsody Drive, 

Recent, Starred, Received View Alerts, Group Document (for group heads only), and search results on the 

Wrapsody website. 

1. Access the Wrapsody website. 

2. Click on the desired tab in the navigation menu to navigate to a document list. 

3. Select the checkbox next to the document you want to analyze (multiple selections allowed). 
4. Click on the AI Document Helper button that will appear at the top. 
5. The AI Document Helper window will appear with the selected document. You can drag and drop additional 

documents to add them. 
6. Click on the guided questions or type your question directly and press Enter. 
7. AI Document Helper will generate and provide answers. 

Note: You can also open the AI Document Helper window by clicking the AI Document Helper button  at 

the bottom right of the page displaying a document list. You can then drag and drop documents to add them. 

On the Home page, the AI Document Helper window opens only when you click the button. 

Route 2. Preview browser 

You can utilize AI Document Helper within the document preview window as well. However, please note that 

you can only pose questions related to the document being previewed, and you cannot add additional 

documents for analysis. 

1. Access the Wrapsody website. 

2. Click on the desired tab in the navigation menu to navigate to a document list. 

3. Click on the More button  for the document you want to analyze. 

4. Click on Preview. 

5. Click on the AI Document Helper  tab on the right. 

6. The AI Document Helper pane will expand. 

7. Click on the guided questions or directly input your question and press Enter. 

8. AI Document Helper will generate and provide answers. 

5.5. Smart Cleaner 
Smart Cleaner intelligently filters out ROT (Redundant, Obsolete or Trivial) files, significantly reducing 

redundant and unnecessary files, thereby enhancing productivity and security. GCC Recommendation enables 

you to download, share, organize, exempt and delete files that are recommended for GCC (Garbage Content 

Collection).  

5.5.1. GCC Recommendation 

A list of files recommended for GCC is displayed. Select files you wish to organize from the list and either 

delete or exempt them from GCC.  
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1. Go to Smart Cleaner > GCC Recommendation. 

2. Select a tab (All, Obsolete, Similar, Exempted) at the top according to the desired GCC type to view.  

3. The list below is updated according to the selected tab.  

4. Click  to perform a thorough search using file names or tags.  

5. Select the checkbox to the left of a file that you intend to organize. This will prompt the following 

Download, Exempt and Remove buttons located just above the File name heading 

 
6. Refer to the GC type of the selected file to exempt or delete the file.  

Item Description 

Similar files Files that are derived from another document and have identical content to the original. 

Obsolete Files that have not been used for more than a year. 

Exempt Obsolete Files 

1. Select the checkbox to the left of a file that you intend to exempt from the files recommended for GCC in 

the Obsolete tab.  

2. Check the Counts column to see the number of unused versions out of total versions.  

E.g.: If the count is 1/3, it indicates the file have a total of three versions, with one version being a file 

that has not been used for an extended period. 

3. Click the View Targets button on the right of GC Type. The button is enabled only for Obsolete-type files.  

4. You can review the content of the specific version through the web preview.    

5. To exempt a file, select the checkbox to the left of the file and click the enabled Exempt  button at the 

top. 

6. The version is excluded from the GCC recommendation list. 

7. The files that have been exempted will appear in the Exempted tab.  

Delete Obsolete Files 

1. Select the checkbox to the left of a file that you intend to exempt from the files recommended for GCC in 

the Obsolete tab. 

2. Check the Counts column to see the number of unused versions out of total versions. 

E.g.: If the count is 1/3, it indicates the file have a total of three versions, with one version being a file 

that has not been used for an extended period. 

3. Click the View Targets button on the right of GC Type. The button is enabled only for Obsolete-type files.  

4. You can review the content of the specific version through the web preview.    

5. To delete a file, select the checkbox to the left of the file and click the enabled Remove  button at the 

top. 

6. When a confirmation dialog box for deletion appears, click Delete. 

7. The files will be relocated to the Recycle Bin.  

Exempt Similar Files 

1. Select the checkbox to the left of a file that you intend to exempt from the files recommended for GCC in 

the Similar tab (multiple selections allowed).  

2. To view the content of GCC target files, click the enabled Preview  icon next to the GC Type. 

3. Click the  button on the far right side to see a list of similar files that have duplicate content with the 

GCC target file. By clicking the Download  icon of the file for each version, you can compare content 

with the GC target file.  

4. Click the Exempt  button if you want to keep the file as the GCC target file.  
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5. The file will be excluded and disappear from the GCC recommendation list. The files that have been 

exempted will appear in the Exempted tab.  

Delete Obsolete Files 

1. Select the checkbox to the left of a file that you intend to delete from the files recommended for GCC in 

the Similar tab (multiple selections allowed).  

2. To view the content of GCC target files, click the enabled Preview  icon next to the GC Type. 

3. Click the  button on the far right side to see a list of similar files that have duplicate content with the 

GCC target file. By clicking the Download  icon of the file for each version, you can compare content 

with the GC target file.  

4. Click the Remove  icon at the top if you think the file is an unnecessary duplicate. 

5. The file will be deleted and relocated to the Recycle Bin. 

Cancel Exemption 

1. Select the checkbox to the left of a file for which you intend to cancel the exemption from the files 

recommended for GCC in the Exempted tab (multiple selections allowed). 

2. Click the Unexempt  icon at the top. 

3. The file will no longer appear in the Exempted tab and will instead be moved back to the Obsolete or 

Similar tab.    
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5.6. Request 
You can review requests that you have submitted and are pending approval, or those that you have received 

and have already been approved or rejected. My requests shows the list of requests submitted by the logged-

in user. For requests that have not yet been approved, you have the option to withdraw them. 

Approve/Reject shows the list of requests the logged-in user has received from other users. Within this 

section, the logged-in user has the authority to either approve or reject these requests.   

5.6.1. My Requests 

My requests shows the list of requests submitted by the logged-in user. 

1. Go to Request > My Requests. Click the Pending tab to view the pending requests, and click the Compete 

tab to see the already approved or rejected requests.  

2. Click  located at the top right. This action will activate search filters, enabling you to perform a 

detailed search.  

 
3. Select items from Request type and specify Period by choosing a time option. For Folder/File name, enter 

folder or file names in the search box and then press the Enter key to include them as search terms. For 

Owner, you can enter a name in the search box and select the intended user from the search results 

below.    

Request type Description 

End Editing 
When approved, the user who has checked out and has been revising 
the file will cease editing the file. 

Transfer File 
Ownership 

When approved, the requester will become the owner of the file. 

Revise Permission 
When approved, the requester will be granted Revise permission for 
the file  

View Permission 
When approved, the requester will be granted View permission for 
the file 

Permanent 
Deletion 

When approved, the file will be deleted permanently from the server.  

Transfer Folder 
Ownership 

When approved, the requester will become the owner of the folder. 

Export Original 

This request type is applicable exclusively in a Wrapsody Cloud 
Enterprise plan or higher-level plans, where Export Original is 
restricted. If approved, the requester is permitted to unwrap the file 
and export it as an original only once. 

4. The file list is refreshed based on the specified conditions.   

5. To cancel unapproved requests in the Pending tab, simply select the checkbox to the left of the request 

you want to cancel, and then click the Cancel Request  icon.   

5.5.2. Approve/Reject 

Approve/Reject shows the list of requests the logged-in user has received from other users.  
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1. Go to Request > Approve/Reject. Click the Pending tab to view the pending requests, and click the 

Compete tab to see the already approved or rejected requests.  

2. Click  located at the top right. This action will activate search filters, enabling you to perform a 

detailed search.  

 
3. Select items from Request type and specify Period by choosing a time option. For Folder/File name, enter 

folder or file names in the search box and then press the Enter key to include them as search terms. For 

Owner, you can enter a name in the search box and select the intended user from the search results 

below.    

Request type Description 

End Editing 
When approved, the user who has checked out and has been revising 
the file will cease editing the file. 

Transfer File 
Ownership 

When approved, the requester will become the owner of the file. 

Revise Permission 
When approved, the requester will be granted Revise permission for 
the file  

View Permission 
When approved, the requester will be granted View permission for 
the file 

Permanent 
Deletion 

When approved, the file will be deleted permanently from the server.  

Transfer Folder 
Ownership 

When approved, the requester will become the owner of the folder. 

Export Original 

This request type is applicable exclusively in a Wrapsody Cloud 
Enterprise plan or higher-level plans, where Export Original is 
restricted. If approved, the requester is permitted to unwrap the file 
and export it as an original only once. 

4. The file list is refreshed based on the specified conditions.   

5. To approve or reject pending requests in the Pending tab, just check the checkbox next to a request, and 

then click the respective Approve or Reject icon.  
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5.7. Log 
Your file usage log is accessible in My Usage. In Owned Document, you can observe activities performed by 

other users on files owned by you.  

5.7.1. My Usage 

1. Go to Log > My Usage.  

2. The list of the recently used document by the logged-in user is displayed, along with the following search 

filters positioned at the top.  

 
3. From the Type dropdown, select either file usage or management options. 

 
4. Specify Period by choosing a time option. To conduct a search by File name, input the desired name in the 

search box and press Enter. Similarly, you can enter a file owner’s name in the search box and select the 

intended user from the search results below. 

5. The usage history list is refreshed based on the specified conditions.  

6. To export the list of your file usage history to an Excel file, click Export at the top right corner of the page. 
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5.7.2. Owned Document 

1. Go to Log > Owned Document.  

2. The list of the files owned by the logged-in user is displayed, along with the following search filters 

positioned at the top.  

 
3. From the Type dropdown, select either file usage or management options. 

 
4. Specify Period by choosing a time option. To conduct a search by File name, input the desired name in the 

search box and press Enter. Similarly, you can enter a file owner’s name in the search box and select the 

intended user from the search results below. 

5. The usage history list is refreshed based on the specified conditions.  

6. To export the list of your owned file usage history to an Excel file, click Export at the top right corner of 

the page. 
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5.8. Analytics 
In Analytics, you can have an at-a-glance view of usage patterns and trend analysis. This can be achieved 

either across the entire organization or by focusing on specific targets, all based on statistical data.   

5.8.1. Analytics[Organization] 

Analytics[Organization] shows weekly analysis concerning the comprehensive usage of Wrapsody files across 

the company.

 

See the table below for additional details regarding the Analytics[Organization] section.  

Item Description 

Duration 

Click  located at the top right corner to view the available Period 
options. Select from options including Last 1 week, Last 1 month and Last 
1 year. The statistical data will be then displayed base on your selected 
period. Click Custom period and specify the period by setting the Start 
Date and End Date manually.  

Revised 
Activities: The total number of times employees have checked in files 
Average: The total number of Revise divided by the total number of users. 

Viewed 
Activities: The total number of times employees have viewed files 
Average: The total number of View divided by the total number of users. 

Engaged (Inbound) 

Activities: The number of times that the total employees have viewed a file 
within a period set on the server since the date the file has been checked 
in. 
Average: The total count divided by the total number of users 

Engaged (Outbound) 

Activities: The total count of users who have been granted with View or 
Revise permissions within the designated period since the date when the 
file was checked in. 
Average: The total count divided by the total number of users 

Daily Usage Trend 
The graph illustrates the daily counts trend of Revised, Viewed, Engaged 
(Inbound) and Engaged (Outbound) during the selected period. 

Top 10 - Revised Ranking of the top 10 users who have checked in files most often 
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5.8.2. Analytics[Group] 

You can compare your usage analysis results with the average either of the organization or the group you 

belong to. 

 

See the table below for additional details regarding the Analytics[Group] section. 

Item Description 

Duration 

Click  located at the top right corner to view the 
available Period options. Select from options including Last 1 
week, Last 1 month and Last 1 year. The statistical data will be 
then displayed base on your selected period. Click Select 
period and specify the period by setting the Start Date and End 
Date manually. 

Summary 

Revised 
The number of times you have checked in files within the 
selected period. 

Viewed 
The number of times you have viewed files within the selected 
period. 

Engaged 
(Inbound) 

The number of times that you have viewed a file within a 
period set on the server since the date the file has been 
checked in. 

Engaged 
(Outbound) 

The total count of users who have been granted with View or 
Revise permissions within the designated period since the date 
when the file was checked in. 

Wrapsody 
Proficiency 

Index 

Tags per doc 
The number of tags added per owned file during a set period 
(Required, Optional, user tags all combined) 

 Users per doc 
The number of users you have granted View or Revise 
permission per owned file during a set period 

Alerts sent 
The number of times you have sent a View request during a set 
period 

Documents 
deleted 

The number of files you have deleted during a set period 

Branches created 
The number of times you have created a branch file during a 
set period 

Daily Usage Trend 
The graph illustrates the daily counts trend of Revised, Viewed, 
Engaged (Inbound) and Engaged (Outbound) for chosen users 
or groups during the selected period. 
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6. Wrapsody Drive for Desktop 
Wrapsody Drive for Desktop, accessible on your PC, is made for efficiently managing all your Wrapsody Drive 

files in a structure that looks like File Explorer. It is presented as Wrapsody Drive (W:) in This PC, and it syncs 

smoothly with Wrapsody Drive and Wrapsody Drive Web. The personal drive (displayed by user name and ID), 

group drive (displayed by group name), and the company drive are visible. Additionally, for group heads, the 

drive of their managed group is also displayed. 

 

6.1. Check Wrapsody Drive Usage Status 
There are storage limits for each company, group, and personal drive in Wrapsody Drive. You can view 

information about the storage limits and the currently used storage space for each drive. 

Note: If storage space is running low, you may not be able to save new files to the drive. However, creating a 

new version by checking in existing files is still permitted. 
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 Total 

The allocated storage limit for the drive. 

 Used 

The storage currently occupied, representing the combined size of the latest versions of files. 

 Free 

The remaining storage space. 

 Total capacity of all file versions 

The total capacity of all versions of all files in the drive. 

Follow these steps to check the usage status of each drive. 

1. Open File Explorer. 

2. Right-click on the personal, group, or company drive in Wrapsody Drive (W:). 

3. Select Drive Properties. 

4. The details window for the respective drive will appear. 

Note: The Drive Properties is not enabled for subfolders within each personal, group, or company drive. 

6.2. File Management 
In Wrapsody Drive for Desktop, you can right-click a file to access a menu for managing files. 

 

6.2.1. Synchronize all files in the same folder 

Wrapsody Drive for Desktop automatically syncs with the Wrapsody Server in real time, ensuring files are 

always up-to-date. Additionally, you can manually synchronize files in Wrapsody Drive for Desktop. 

1. Open File Explorer. 

2. Select the Personal, Group or Company Drive located within Wrapsody Drive (W:).  

3. Right-click a file within the drive and select Synchronize All Files in Same Folder. 

4. All files, including the selected file, in the folder will synchronize. 

6.2.2. Manage a file as link files 

In Wrapsody Drive for Desktop, you can store files by converting them into link files. Link files occupy zero 

memory space and function as shortcuts, distinguished by a green overlay mark  at the bottom left of the 

icon. 

E.g.:  or  

Convert to a link file 

1. Open File Explorer. 

2. Select the Personal, Group or Company Drive located within Wrapsody Drive (W:).  

3. Right-click on a file within the drive and select Convert to Link File. 

4. The file will transform into a link file, marked with the green overlay at the bottom left of the icon. 
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Convert to an actual file 

1. Open File Explorer. 

2. Select the Personal, Group or Company Drive located within Wrapsody Drive (W:).  

3. Double-click and launch a file with the green overlay (e.g., ). 

4. The file will be downloaded from the server and converted into the actual file, with the overlay 

disappearing. 

6.2.3. Manage plain file history  

You can view the version history of plain and unwrapped files in Wrapsody Drive and download each version.  

1. Open File Explorer. 

2. Select the Personal, Group or Company Drive located within Wrapsody Drive (W:).  

3. Right-click a file within the drive and select Plain Document History.  

4. The Plain Document History dialog pops up, showing the version history.   

6.2.4. Rules for Wrapsody Drive File Permissions 

 Inheriting Folder Permissions 

Files in Wrapsody Drive inherit permissions from their respective folders. Write permissions for a folder 

automatically grant Revise permissions to users for the files within, and Read permissions grant View 

permissions. If folder permissions change, the corresponding file permissions will adjust accordingly. It is 

important to note that file owners are unable to delete or change the manager of the folder containing 

the file. 

 Separate Configuration of Permissions 

File owners can independently configure permissions through the Set Users window, and these settings 

remain unaffected by permissions automatically inherited from the folder. These separately set 

permissions remain unchanged even if there are changes to the folder permissions. 

 Priority of Permissions 

The user's final permission for a file is decided by whichever is higher between the automatically inherited 

permissions from the folder and the separately configured permissions set by the file owner. This ultimate 

permission is displayed in the Permission section of the Details window. 

Example: If you have Revise permission for a file in a folder where you only have Read permission, the 

inherited permission from the folder is View. However, since you already have Revise permission for the file, 

the Details window will show you as a user with Revise permission. 

6.2.5. Save a file to Wrapsody Drive 

Save your file directly to Wrapsody Drive. 

1. Open an application such as Word or PowerPoint on your PC to create a new file. 

2. Enter your content and click the Save button. 

3. On the Save page, click the Browse button. 

4. Go to a folder in Wrapsody Drive for Desktop, choose a folder where you have Write permissions, and 

click Save in the Save As dialog. 

5. Your file will be saved in the selected folder. Please note that the user creating and saving the file will be 

the file owner, and the file permissions will inherit the permissions of the chosen folder (Refer to Rules for 

Wrapsody Drive File Permissions). 

6.2.6. Copy a file 

You can copy a file if you have View or higher permissions (or Revise permissions, depending on the server 

settings). After copying it, you can paste the file either within your Drive or transfer it between Wrapsody 



 

Wrapsody Cloud v5.9.2 User Guide | Page 94 

Drive and external locations. Refer to the accompanying diagram to visually understand the outcomes of 

copying and pasting a file within Wrapsody Drive or between Wrapsody Drive and external locations. 

 

Outcomes 

 Wrapsody Drive to Local path: A file with the identical file ID will be created in the local path, retaining the 

same file permissions. 

 Local path to Wrapsody Drive or Within Wrapsody Drive: A branch file under the same file name but with 

a different file ID will be created. The user who copies the file becomes the file owner, and the file 

permissions set before are reset. The file will inherit the permissions of the destination folder (Refer to Rules 

for Wrapsody Drive File Permissions). 

 Plain files:  They remain as plain files after being pasted, or will be wrapped according to the Wrapping 

policies. 

 Plain files in Wrapsody Drive: For plain files, which are also Wrapsody Drive files, the file permissions can 

be checked on Wrapsody Drive Web (Refer to Check permissions for a plain file). 

6.2.7. Move a file 

Users with file managing permissions, including the folder owner, file owner, head of group, and 

administrators, can move files to a folder for which they have Write permissions within Wrapsody Drive. 

However, this movement is only available within their Personal, Group, or Company drive respectively. The file 

ID will remain unchanged. Additionally, separately set file permissions will not be changed, inheriting 

permissions of the destination folder simultaneously (Refer to Rules for Wrapsody Drive File Permissions). 

Note: Moving files directly between Wrapsody Drive and local folders outside the Drive is not possible. If users 

try to move a file between these locations, the outcomes will mirror those of copying files between them 

(Refer to Copy files). 

6.2.8. Rename a file in Wrapsody Drive 
Rename a file for which you have Revise permission in Wrapsody Drive for Desktop. 
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1. Open File Explorer. 

2. Select the Personal, Group or Company Drive located within Wrapsody Drive (W:).  

3. Right-click either a plain or Wrapsody file within the drive and select Rename. 

4. Enter the new name and press the Enter key. 

5. The file name will change, and the Drive will synchronize, promptly updating the file name on Wrapsody 

Drive Web to reflect the modification. 

6.2.9. Delete a file from Wrapsody Drive 

Delete files within a folder where you have Write permission in Wrapsody Drive. If you are not the file owner, 

an email or push message will be sent to the file owner when the file is deleted. 

1. Open File Explorer. 

2. Select the Personal, Group or Company Drive located within Wrapsody Drive (W:). 

3. Right-click either a plain or Wrapsody file within the drive and select Delete, or simply press the Delete 

key. 

4. The file will disappear from Wrapsody Drive for Desktop, relocating to the file owner’s Recycle Bin on the 

server. 

Note: When a file is deleted from Wrapsody Drive, it goes to the file owner’s Recycle Bin on the server, 

resetting the file permissions inherited from the folder. The file owner can restore the file from the Recycle Bin 

or initiate a request for permanent deletion (Refer to Restore a Wrapsody Drive file, Restore from Recycle Bin, 

and Request permanent deletion). 

6.2.10. Restore a file to Wrapsody Drive  

Users who have Write permissions for a folder can restore a deleted file within the folder. 

1. Open File Explorer. 

2. Right-click the folder that previously contained the deleted file you want to restore in Wrapsody Drive for 

Desktop and then select Folder Properties.  

3. When a Wrapsody Details window appears, click the Timeline tab located at the top. 

4. Within the file deletion record box, click Restore. 

 
5. The deleted file will be restored.  
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6.3. Folder Management 
A folder in Wrapsody Drive for Desktop can be administered by either the assigned folder manager or a user 

with appropriate permissions for that folder. These users have the authority to perform actions such as 

deleting, moving, and copying the folder, configuring folder permissions, and renaming it. However, the ability 

to rename, move, delete a folder, and set folder permissions may be granted specifically to the folder manager 

based on the server settings. 

6.3.1. Manage folders  

You can manage folders by accessing either the Details or Timeline tab within the Properties window. 

Details 

1. Open File Explorer. 

2. Right-click a file in Wrapsody Drive (W:) and select Folder Properties. 

3. A Wrapsody Details window appears. 

 
❶ Basic info: Displays the folder structure in Wrapsody Drive, indicating the number of nested folders 

and files, along with the folder path. A Delete  icon is visible only to users with the necessary 

permissions to delete the folder. Note that attempting to delete files by clicking the Delete icon within the 

folder will not work if there are files present. 

❷ General: Displays information such as the folder manager’s identity, creation date and modification 

date. If you are not the folder manager,  will be enabled. For more details, refer to 

Request folder ownership. 

❸ Permission: Lists users or groups with Write or Read permissions for the folder.  will be 

enabled for users who have the authority to configure folder permissions, allowing them to set 

permissions for each user or group. Please note that this Set Users button will be disabled for the Personal 

Drive, as only the drive owner has the authority over the folders within. For more details, refer to Set 

folder permissions. 

❶ 

❷ 

❸ 
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Timeline 

1. Open File Explorer. 

2. Right-click a file in Wrapsody Drive (W:) and select Folder Properties. 

3. When a Wrapsody Details window appears, click the Timeline tab located at the top. 

 

❶ Filter: Click  at the top right corner of the Timeline tab to reveal 10 filters in the form of 

icons. Hovering over each icon will display the corresponding filter name. When you select filters such as 

Create Folders, Change Folder Name, Move Folders, Remove Folder, Restore Folder, Add file, Delete file, 

Restored file, Move file and Renamed file (from left), whether one or multiple, the history of folder 

management actions associated with those filters will appear. 

❷ Folder history: Every history record displays the users who carried out folder management actions, 

the type of management action taken, and the timestamp of the action. 

Set folder permissions 

A folder manager or a user with Write permissions for a folder can assign permissions for each user and group. 

However, this action might be restricted to the folder manager depending on the server settings. 

1. Open File Explorer. 

2. Right-click a file in Wrapsody Drive (W:) and select Folder Properties. 

3. A Wrapsody Details window appears. 

4. Click  in the Permission section, and a window will appear as shown below. 

❶ 

❷ 
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5. Select users or groups either in the Select from group or Favorites tab, and the chosen users or groups 

will be added to the list on the right. 

6. Click the toggle button to select Read or Write permission to grant. 

7. To apply the newly set or revised permissions, click Apply. To discard changes, click Cancel. 

Request folder ownership 

Users who are not the manager of a folder but have permissions for it can request folder ownership from the 

folder manager. Once ownership is transferred, the previous folder manager will be automatically granted 

Write permission for the folder. 

1. Open File Explorer. 

2. Right-click a file in Wrapsody Drive (W:) and select Folder Properties. 

3. A Wrapsody Details window appears. 

4. Click Request Ownership under the Folder Manager’s identity in General. 

 
5. When a request window appears, enter a reason for the request, and click OK. 

 
6. When the request completion window appears, click OK. 

7. If the folder manager accepts the request, the requester will become the new folder manager. 
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6.3.2. Create a folder in Wrapsody Drive 
Users can create a folder in their Personal, Group, or Company Drive. If the folder is created in a location 

where you have Write permissions within the Group or Company drive, you automatically become the folder 

manager, inheriting permissions from the parent folder. 

1. Go to File Explorer > Wrapsody Drive (W:). 

2. Enter either your Personal Drive (displayed as "user name (user ID)"), your Group Drive (displayed as the 

group name), or Company Drive.

 
3. Right-click on empty space, select New and then Folder. 

4. Enter the folder name, press the Enter key, and the folder with the specified name will be created. 

6.3.3. Copy a folder 

You can copy a folder if you have View or higher permissions. After copying it, you can paste it within your 

Drive or transfer it between Wrapsody Drive and external locations. 

Outcomes 

 Wrapsody Drive to Local path: A folder with the identical name will be created in the local path. 

 Local path to Wrapsody Drive or Within Wrapsody Drive: The user who copies the folder becomes the 

folder manager, and the folder inherits permissions from the destination folder. Notably, when the copying 

action occurs within Wrapsody Drive, separately set folder permissions by the original folder manager will 

not be maintained. 

 Files in the folder will act according to the Copy a file process. 

6.3.4. Move a folder 

Users with folder managing permissions, including the folder owner, head of group, and administrators, can 

move a folder to another folder for which they have Write permissions within Wrapsody Drive. 

Note: Moving folders directly between Wrapsody Drive and local folders outside the Drive is not possible. If 

users try to move a folder between these locations, the outcomes will be similar to copying folders between 

them (Refer to Copy a folder). 

Outcomes 

 Even after a folder is relocated, the folder permissions will be maintained. 

 Files in the folder will act according to the Move a file process. 

6.3.5. Rename a folder in Wrapsody Drive 

A folder manager has the capability to change the name of a folder within Wrapsody Drive. Users with Write 

permissions for a folder may also rename the folder based on the sever settings. 

1. Go to File Explorer > Wrapsody Drive (W:) > Personal Drive / Group Drive / Company Drive. 

2. Right-click on the folder you want to rename and choose the Rename option. 

3. Enter the new name and press the Enter key. 

4. The file name will be updated, and the Drive will promptly synchronize, ensuring that the modified name 

is reflected on Wrapsody Drive Web. 
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6.3.6. Delete a folder from Wrapsody Drive  

A folder manager or users with Write permissions for a folder can delete the folder. The folder manager may 

exclusively possess the authority to delete the folder, depending on the server settings. When a folder is 

deleted, the files within the folder are relocated to the file owner’s Recycle Bin on the server. 

1. Go to File Explorer > Wrapsody Drive (W:) > Personal Drive / Group Drive / Company Drive. 

2. Right-click on the folder you want to delete.  

3. Choose the Delete option. 

4. In the Delete Folder window, click Yes. 

5. The folder is now deleted and no longer visible in the specified path. 

Note: If you attempt to delete the folder using the Recycle Bin  icon in the Details window accessed through 

Wrapsody Drive for Desktop, the action will be successful only if there are no files within the folder. 

6.3.7. Restore a folder to Wrapsody Drive  

1. Open File Explorer. 

2. Right-click the parent folder of a deleted folder in Wrapsody Drive and then select Folder Properties.  

3. When a Wrapsody Details window appears, click the Timeline tab located at the top. 

4. Within the folder deletion record box, click Restore. 

 
5. The deleted folder is restored. However, the deleted files in the previously deleted folder will not be 

restored automatically. You will need to manually restore them using the following steps. 

6. Right-click a restored folder and select Folder Properties. 

7. Click the Timeline tab. 

8. In the folder management history list, find the records of deleted files you want to restore, and click 

Restore in each corresponding box. 
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6.3.8. Export multiple originals in Wrapsody Drive 

This feature enables you to unwrap multiple files from folders within Wrapsody Drive and save their original 

files to your PC all at once. However, according to the company policy set by the administrator, this feature 

might not be available. 

1. Open File Explorer. 

2. Right-click a folder in Wrapsody Drive and select Export Multiple Originals.  

3. The Export Multiple Originals dialog appears as below. 

 
4. When the Browse for Folder dialog appears, select the folder to save the original files, and click OK. 

5. Select the checkboxes corresponding to your desired options below the Options heading. 

6. When you click the Start button, the unwrapped original will be saved in the specified location and 

marked as Complete under Status. 


